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SECTION 1 ABOUT UM8000® 

UM8000 is a complete, self-contained voice messaging system consisting 
of a single plug-in blade that is installed directly into the SV8100/SV8300 
telephone system.

The voice blade includes hardware support for up to 16 voice ports and 
four fax ports. The voice blade also includes a compact flash disk (CF) that 
stores the voice messaging software and all voice recordings.  All software 
required to run the UM8000 system is pre-installed, including the Linux® 
operating system and the UM8000 voice messaging system.

1.1 Supported Phone Systems

The UM8000 system is designed specifically for use with the 
SV8100/9100 and SV8300/9300 telephone system manufactured 
by NEC.

The SV8100/SV8300 is enabled for the following UM8000 licenses 
at default:

• 0 Ports Voice Mail

• 5 Seats Unified Messaging

• 3 Languages

In addition, the following language prompt sets are loaded at 
default:

• US English

• French (Canadian)

• Spanish (Latin America)

NOTE

. System ports can not be set to fax-only.
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1.2 Starting the UM8000 for the First Time

Before starting the UM8000 for the first time, make the required settings and 
license agreements.  Refer to Chapter 3 Section 2 Starting the UM8000 for the 
First Time on page 3-2 for information on third party software license 
agreements that must be accepted before the voice mail application can start.

If the license agreements are not accepted, the application cannot start.

SECTION 2 ABOUT THIS GUIDE

This Installation Guide provides complete instructions for installing and setting up a 
UM8000 voice messaging system.

2.1 Documentation Conventions

The following conventions are used throughout this guide.

• Key names. Names of keys on the keyboard are shown in capital letters.

 Example:  OK 

When two keys must be pressed simultaneously they are joined by 
a + sign.

Example:  ALT+TAB

• User input. Information required to be typed is shown in a distinctive font.

Example:  Type  names first 

• Placeholder text. Variable text that will be replaced by specific text is 
shown in italics between angle brackets. 

Example:  vmctl <service> <action> <ENTER>

NOTE

. On the command line prompt, always press <ENTER> after typing a 
command.
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• Notes, cautions, and warnings. Text for notes, cautions, and warnings 
appear as shown below:  

 

• <ENTER>. Press the ENTER key on the keyboard when this character 
string appears after a command. In general, all command lines should be 
followed by pressing the ENTER key. 

Example:  vmctl vmail stop <ENTER>

NOTE

. A note provides additional information to supplement the main text. A note 
provides helpful information, but is not essential to understanding the 
current topic.

CAUTION

. A caution advises you that failure to avoid or to take a specific action might 
lead to unwanted or undesirable results.

WARNING

. A warning advises you that failure to avoid or to take a specific action 
might result in physical harm to the user, damage to the hardware or loss of 
data.
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2.2 Using the Command Line Interface

Communicating with the Linux operating system remotely using Microsoft® 
Windows® requires the use of tools and shells such as WinSCP and PuTTY.

All procedures in this document are based on the WinSCP and PuTTY 
applications.  When using both applications, input devices include the 
keyboard or mouse.  Use the input device that you prefer.

    

Input 
Device

Mouse
Click to choose Maintenance menu items and buttons; choose items in 
the Web administration console; and choose items or buttons in 
WinSCP.

Keyboard

Command 
Prompt

Type a command with options then press the ENTER 
key. For example:

mcedit /cps.ini <ENTER>
This command opens the cps.ini file in the mcedit tool.

1, 2, 3,... 0 
To choose a menu item, type the numeric equivalent of 
a menu item. For example: 0 = Log out on the 
Maintenance menu.

TAB
Press the TAB key to move through menu items and 
command buttons in the Maintenance menu.

UP (↑), 

DOWN (↓), 

LEFT (←), 
and

RIGHT (→   )     

Use the keyboard arrow keys to move between menu 
items, buttons, or options.

Function 
Keys

Tools such as mcedit use function keys to execute 
specific actions. For example: F10, exits mcedit; F5 
saves the file, and so on.

SPACEBAR

Press the SPACEBAR to toggle check marks off and 
on. For example,

(*) Messages

Pressing the SPACEBAR clears the check box.
( ) Messages
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SECTION 3 RELATED DOCUMENTATION

3.1 Supporting Documents

The documentation set for the UM8000 voice messaging system consists of 
the following:

• Installation Guide – Provides instructions for installing and setting up a voice 
messaging system.

• System Management Help – Provides online information and instructions for 
managing the voice messaging system.

3.2 System Management Help

System Management Help provides immediate assistance while using the 
Web administration console.

• Click the HELP icon to see context-sensitive help for the current page. Refer 
to Chapter 3 Section 5 Web Administration Console Icons on page 3-14. 

• System management help can be installed locally on any computer for 
viewing. WinZip, or a similar file decompression program, is required to 
extract the help files.

NOTE

. Pop-up windows must be enabled on the Internet browser to access 
some features of the Web administration console and system 
management help.  To enable pop-up windows for a specific site, refer to 
the Internet browser documentation.



Issue 8.0 UM8000

1 - 6 Introduction

SECTION 4 RELATED INFORMATION

4.1 Client Applications and Protocols

Different clients requier different ports to be available for access. The following 
table lists those clients and their required ports. 

Client App. --> WAC 
http

WAC 
https

WMM
http

WMM
https

View
Apps

Secure 
Remote 
Access

AIMWorkX 
& 
MA4000

Port Purpose

80 HTTP X X

443 HTTPS X X

20751 JAVA X X X X

251 XML X X X X

20751 Start/Stop X X

1024 RPC X

22 SSH X

2005 AIMWorX X
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4.1.1 Locally Installing Online Help Files

1. Download the self-extracting file from the NTAC download site
(Solution ID S4F2NAJ) from https://www.necntac.com/. This
wildownload all help web pages and PDFs.

2. Double click on the file. It will automatically extract the files to:
C:\UM8000 OnLine Admin. 

3. To open the On-line Help, scroll to the bottom of C:\UM8000
OnLine Admin, and double click wwhelp.htm. This will open a
web browser window with the help information.

4. Allow the blocked ActiveX content to run, if prompted.

. It maybe helpful to make a shortcut of this by right clicking on wwhelp.htm 
and choosing "Send to Desktop".

4.1.2 Third-Party Documentation

Compliance information for third-party electronic devices is provided 
in the third-party manufacturer documentation supplied with the 
UM8000 system.

Do not use third-party documentation to install, upgrade or manage 
the voice messaging system. Use only the UM8000 documentation 
to install, upgrade, or manage the voice messaging system. 



Issue 8.0 UM8000

1 - 8 Introduction



Installation Manual 2 - 1

W
in

S
C

P
 a

n
d

 P
u

T
T

Y

2WinSCP and PuTTY 

SECTION 1 OVERVIEW

WinSCP (file transfer) and PuTTY (SSH utility) are open source programs 
that have been tested and approved for use with the voice messaging 
system.

These programs can be downloaded from the Internet.

SECTION 2 WINSCP

2.1 Installing WinSCP

The following procedure provides instructions for installing the 
WinSCP Client:

1. Download WinSCP.

2. Using Windows Explorer, browse to the downloaded file.

3. Double-click the downloaded file to start the WinSCP 
installation. 

A security alert message appears.

4. Click RUN.

The Select Setup Language page appears.

5. Choose the appropriate language from the drop-down list, 
then click OK. 

The Welcome to WinSCP Setup Wizard appears.

6. Click Next.

7. On the License Agreement page, click Next.

8. Accept the default installation path or type a new path, then 
click Next.
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The Select components page appears.

9. Accept the default components. If appropriate, choose a language for 
translation, then click Next.

10. Accept the default Start Menu folder name or type a new name, then click 
Next.

The Select Additional Tasks page appears.

11. Accept the default additional task settings, then click Next.

The Initial user settings page appears.

12. Select one of the user interface styles, then click Next. All WinSCP 
procedures in this document assume that the Norton Commander 
interface is being used.

  

The Ready to Install page appears.

13. Verify that the settings are correct, then click Install.

To review or change any of the settings, click Back.

When the installation is complete, the Completing WinSCP3 Setup Wizard 
page appears.

14. Clear the Start WinSCP now check box, then click Finish.

Interface Style Description

Norton Commander
(Preferred Option)

Displays source computer directories in the left pane 
and destination computer directories in the right pane.

Explorer-like
Displays directories in the left pane and files in the 
right pane.
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2.2 Using WinSCP

The following instructions assume that WinSCP is installed on a computer 
running the Windows XP operating system.

2.2.1 Running WinSCP

The following procedure provides instructions to run WinSCP:

1. Click Start > Programs > WinSCP3 > WinSCP.

The WinSCP Login window appears.

2. Click Session.

3. Type the Host name (or IP address), User name, and 
Password. 

4. Click SAVE to save the login information for future sessions.

5. Click LOGIN.

A potential security breach message might appear, click YES.

The WinSCP console appears.

NOTE
. The IP address for the voice mail is assigned in chassis 

programming 10-55-xx (this may be different for your switch, 
please see your switch documentation for details).  At default 
this address is 172.16.1.xxx, where .xxx is the slot where the 
CD-VM00 is installed.  Slot 1 is .100, slot 2 is .101, slot 5 is 
.104, and so on.  The user name: admin, and password: 
voicemail.
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2.2.2 Using PuTTY from WinSCP

This procedure assumes that PuTTY is installed. Refer to 
Section 3.1 Installing PuTTY.

1. In WinSCP, click Commands > Open in PuTTY.

When the first connection is made, a PuTTY security alert 
appears. The alert does not appear in subsequent connections. 
Click Yes.

The PuTTY window appears with a password prompt.

2. Type the admin password: voicemail.

When a connection is established, the Maintenance menu 
appears. To use PuTTY without WinSCP, refer to Section 3 
PuTTY.

SECTION 3 PUTTY

3.1 Installing PuTTY

After configuring the TCP/IP settings, run a PuTTY SSH client on the remote 
computer to connect to the voice board, and complete the software 
configuration.

The following procedures assume that PuTTY will be installed on a computer 
running the Windows XP operating system.

Use this procedure to install PuTTY on the voice messaging system, a client 
computer, or on a remote computer.

To install the PuTTY, perform the following procedure:

1. Download the PuTTY installation files..

2. Using Windows Explorer, go to the directory where PuTTY was 
downloaded.

3. Double-click downloaded file to start the PuTTY installation.

An Open File security alert message appears.

4. Click RUN.

The Welcome to the PuTTY Setup Wizard appears.

NOTE
. Only PuTTY and WinSCP SSH clients are supported. 
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5. Click Next. 

The Select Destination Location page appears.

6. Accept the default installation path or type a new path, then click Next.

The Select Start menu folder page appears.

7. Accept the default components, if appropriate, choose a language for 
translation, then click Next.

8. Accept the default Start Menu folder name or type a new name, then click 
Next.

9. The Select Additional Tasks page appears.

10. Select the appropriate tasks to complete, then click Next.

The Ready to Install page appears.

11. Verify that the settings are correct, then click Install.

To review or change any of the settings, click Back.

12. Clear the View README.txt check box, then click Finish.

3.2 Configuring PuTTY

To configure PuTTY, perform the following procedure:

1. On the Windows taskbar, click Start > Programs > PuTTY > PuTTY.

The PuTTY Configuration page appears.

2. Use a network crossover cable to connect the voice board to a 
computer.

3. Type in the Host Name (or IP address) field.

The IP address for the voice mail is assigned in chassis programming 
10-55-xx (this may be different for your switch, please see your switch 
documentation for details).  At default this address is 172.16.1.xxx, where 
.xxx will vary depending upon which slot the CD-VM00 was installed.  
Starting with slot 1 this will be .100, slot 2 will be .101, slot 5 will be .104 and 
so on.

4. Click Open.

When the first connection is made, a warning message appears. The 
warning message does not appear for subsequent connections. Click Yes.

After the client connects to the voice board, the login prompt appears: 
Logging On and Logging Off Using PuTTY.  Refer to Section 3.3 Logging On 
and Logging Off Using PuTTY on page 14-5.
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3.3 Using PuTTY

The following procedures assume that PuTTy is installed on a computer 
running the Windows XP operating system and you are using a keyboard and 
mouse as input devices.

Use PuTTY for remote SSH terminal access.

To run PuTTY, perform the following procedure:

1. Click Start > Programs > PuTTY > PuTTY.

The PuTTY Configuration window appears.

2. Type the Host Name or IP address, then press  <ENTER>. 

The shell appears with a login prompt.

3. Type a user name, admin <ENTER>.

4. Type the password at the password prompt, voicemail <ENTER>.

The Maintenance menu appears.

NOTE
. The IP address for the voice mail is assigned in chassis programming 

10-55-xx (this may be different for your switch, please see your switch 
documentation for details).  At default this address is 172.16.1.xxx, 
where .xxx is the slot where the CD-VM00 is installed.  (Slot 1 is .100, 
slot 2 is .101, slot 5 is .104, and so on.)
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SECTION 1 OVERVIEW

The voice messaging system Web Administration Console is a web-based 
application that enables access to the voice messaging system.

The Web Administration Console is accessed using the voice messaging 
system or a networked computer.

. The time and date on the phone system and support PC must match in order 
to log into Web Administration Console.

1.1 Supported Internet Browsers

Because the Web Administration Console is a web-based 
application, an internet browser is required to access the Web 
Administration Console.

Supported web browsers include Firefox 24.4 or above, Google 
Chrome 21.0 or above, or Internet Exporer 10 or above. 

1.2 Configuring Internet Explorer

The following procedure configures Internet Explorer to work with 
the Web Administration Console. Refer to the browser 
documentation to configure other Internet browsers.

To configure Internet Explorer:

1. Start Internet Explorer, then click Tools > Internet Options.

2. Click the Security tab.
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3. Click the Local intranet icon, then click Sites.  The Local intranet dialog 
box appears.

4. Click Advanced

The Local intranet Add Web site dialog box appears.

5. In the Add this Web site to the zone text box, type:

http://<server name>

where <server name> is the IP Address of the voice messaging server.

6. Click Add.

7. Verify that http://<server name> appears in the Web sites list box.

8. Click Close.

9. Click OK to close the Local intranet window.

10. On the Internet Options dialog box, click Custom Level.

The Security Settings dialog box appears.

11. In the Security Settings dialog box, verify the settings for the following 
ActiveX controls and plug-ins:

12. Click OK.

A warning alert message appears.

13. On the warning alert message, click Yes to confirm the security changes.

14. Click OK to close the Internet Options dialog box.

SECTION 2 STARTING THE UM8000 FOR THE FIRST TIME

Before starting the UM8000 for the first time, make the required settings and license 
agreements.  To access settings options and license agreements, connect to the Web 
Administration Console (WAC) using an internet browser.

ActiveX controls and plug-ins Setting

Automatic prompting for ActiveX controls Enable
Binary and script behaviors Enable
Download signed ActiveX control Prompt
Download unsigned ActiveX controls Enable
Initialize and script ActiveX controls not marked as safe Enable
Run ActiveX controls and plug-ins Enable
Script ActiveX controls marked safe for scripting Enable
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If the license agreements are not accepted, the application cannot start.   

The following procedure provides instructions for starting the UM8000 for the first 
time:

1. First determine the IP address of the voice mail by checking program 10-55-01 
(this may be different for your switch, please see your switch documentation for 
details) for the slot where the blade is installed.

2. Start your internet browser and enter the IP address followed by 
/admin in the URL window.  

Example:  172.16.0.100/admin.

3. Press <ENTER>.

4. Accept the certificate and log into the WAC with the user name: $nec.  No 
password is required. 

NOTE

. If the voice mail database is defaulted, this procedure must be repeated.

Figure 3-1  UM8000 Login
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5. You are prompted to accept the third party software license agreement.

Figure 3-2  Third Party Software License Agreement
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6. Choose the phone system where the voice mail is to be installed. 

Figure 3-3  UM8000 Switch Information
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Figure 3-4  UM8000 Integration Options
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7. Set the extension numbers that are assigned to the voice mail in program 
11-02-01(this may be different for your switch, please see your switch 
documentation for details).  Select  Edit All.  Enter the extension number for 
each voice mail port, then click Save. 

Figure 3-5  Entering Switch Extensions for Voice Mail Ports, Screen 1
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Figure 3-6  Entering Switch Extensions for Voice Mail Ports, Screen 2
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8. To register the equipment at this time, enter the registration information on the 
Product Registration Form screen.  The voice mail must have access to the 
internet for the registration to be successful.  You can also choose not to register 
at this time or to be reminded in seven days.
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9. You are now logged into the WAC, but the application is not yet started.

Figure 3-7  System Information
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10. Start the application by going to Server Control and clicking on the Start icon.

Figure 3-8  Server Control Start Icon
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SECTION 3 LOGGING ON TO THE WEB ADMINISTRATION CONSOLE

Use the following procedure to start the Web Administration Console.

. The time and date on the phone system and support PC must match in order to log into 
Web Administration Console.

3.1 Logging In

1. Make sure the voice messaging system is running.

2. Start the Internet browser and click File > Open.

The Open dialog box appears.

3. Type the Web Administration Console URL:

https://<IP address>/admin

Where <IP address> is the voice messaging system server IP address.  The
IP address for the voice mail is assigned in chassis programming 10-55-xx
(this may be different for your switch, please see your switch
documentation for details).  At default this address is 172.16.1.xxx, where
.xxx varies depending on the slot in which the CD-VM00 is installed.
Starting with slot 1, this is .100, slot 2 is .101, slot 5 is .104, and so on.

4. Click OK.

5. Type a system manager ID in the User field.
 

6. In the Password field, type the appropriate security code.
 

7. If appropriate, select a different language.

8. Click Login. 

The Web Administration Console appears.

3.2 Logging Off

Click Logoff at the top right-hand corner of any page.

System Manager ID

New system $nec
Existing system Personal ID

Password

New system Leave password field blank
Existing system Password
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SECTION 4 WEB ADMINISTRATION CONSOLE PAGES

Many of the Web Administration Console pages are divided into four sections.    

Key
Screen 

Location
Description

1 Title bar

Contains the application name, the link to 
the Web Administration Console main 
menu, page/record information, and the 
system date and time.

2 Task bar
Contains the command icons, user logon 
information, and the logoff link.

3
Navigation 

pane
Contains links to other Web Administration 
Console pages.

4 Page
Contains fields where data is entered and 
displayed.

1 2

3 4
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SECTION 5 WEB ADMINISTRATION CONSOLE ICONS

The task bar in the Web Administration Console contains one or more command 
icons at the top. These perform the following functions: 

SECTION 6 WEB ADMINISTRATION CONSOLE MAIN MENU

When the Web Administration Console starts the Main menu appears in the 
navigation pane.

The navigation pane is located on the left side of each system page. The navigation 
pane that has links to the Web Administration Console web pages. Each link in the 
navigation pane contains one or more pages with related fields. To move to a page, 
click the link in the navigation pane. Some links contain multiple pages of related 
settings.

Subscribers. Use these pages to configure settings for individual subscribers 
and guests, and to create subscriber templates. Settings include notification 
schedules, passwords, account permissions, phone greetings, call processing, 
and transfer options.

Call Management. Use these pages to specify how UM8000 answers, 
routes, transfers, and records calls. Settings include call handling settings for the 
operator, opening greeting, any routing applications and menus, languages, and 
voice detect applications.

Groups. Use these pages to configure or create message groups.

Preset Messages. Use these pages to configure scheduled messages.

Icon Description

Save changes.

Search for items of the type you are currently viewing.

Add items of the type you are currently viewing.

Delete items of the type you are currently viewing.

View the previous record.

View the next record.

Open System Management Help.
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Hotel Guests. Use these pages to configure settings for hotel guests. Settings 
include greetings, passwords, wake-up calls, call handling, and message waiting 
notification.

Reports. Use these pages to generate reports of subscriber-based or system-
based information, including message activity, message groups, phone sign-ins, 
disk storage, administration access, port usage, software information, and fax 
activity.

Network. Use these pages to add and view locations within a voice messaging 
network.

System. Use these pages to set general information about the voice messaging 
system, such as site contact information, message storage and playback settings, 
system prompts, schedules, port settings, and phone system integration.

Port Status. Use this page to view the current activity and status of each port 
or incoming phone line. The port status information appears in a new window.

Server Control. Use this page to start or stop the voice messaging software.

NOTE

. The hotel guest pages are only available if the optional hospitality package is 
installed.

NOTE

. The network pages are only available if the optional networking package is 
installed.
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SECTION 1 OVERVIEW

Read this chapter before starting the installation. This chapter provides 
preliminary information and guidelines that help you during the installation.

1.1 System Components

The components listed are included as part of the voice messaging 
system. Gather the information, tools, and hardware listed in this 
chapter before starting the system configuration.

1.2 NEC-supplied Components

Verify that all the following components were shipped with the 
system. If any of these items is missing, contact your sales 
representative.

• UM8000 Blade

• UM8000 CF Drive

• UM8000 Visual Messaging Applications

The Visual Messaging applications enabling subscribers to use desktop 
workstations to access and manage voice messages in various ways are 
available for download from the NEC support site.

Everything needed to support Visual Messaging on the server is pre-
installed on the voice messaging system. Howevr, the Visual Messaging 
applications must be installed on each client workstation.

For information about installing and configuring Visual Messaging, see the 
Visual Messaging Installation Guide.

• Remote maintenance software and voice messaging system 
applications must be installed on a remote computer to 
support remote maintenance.

• An internal or external USB DVD-ROM drive is required to 
read the DVD text-to-speech and language packs.
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1.3 User-supplied Components

In addition to the above components, you also need some or all the following 
user-supplied items.

• Network cable

• A standard CAT-5 network cable for LAN connections

• A crossover network cable for a direction connection to another computer

• Monitor (optional)

Connecting a monitor directly to the CD-VM00, enables you to observe the boot process.

• USB keyboard, compatible with Linux (optional)

Connecting a keyboard and monitor directly to the UM8000 blade enables you to interact 
with the switch, log on and off, and configure the UM8000 blade.

• Antistatic wrist strap

Use an antistatic wrist strap when handling the UM8000 blade.

• Network connection

WARNING

. Failure to use an antistatic wrist strap can cause damage to the 
CD-VM00, the phone system, or both.
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SECTION 2 SITE REQUIREMENTS

Ensure that the phone system is located in a site that meets the following 
requirements:

• The site is cool, dry and free of dust.

• The phone system remains immobile while in operation.

• The phone system cooling vents are not obstructed in any way.

2.1 Site Recommendations

The following recommendations help protect the phone system and UM8000 
from potential damage and unauthorized access:

• Use a surge suppressor or an uninterruptible power supply (UPS) to 
protect the phone system and UM8000 against sudden variations in 
electrical power.

• Do not move the phone system while the power is on.

• Do not remove the UM8000 blade from the phone system while the 
voice messaging system is running. Refer to Chapter 5 Starting and 
Stopping the Voice Messaging Software and System.

• Control access to the room where the phone system and UM8000 are 
installed. Do not install these systems in an area where unauthorized 
persons might have access to them.

Failure to follow these recommendations can result in damage or 
unauthorized access to the system and loss of data.

2.2 Setting Up the System Overview

The following summary includes the major steps required to install a new 
UM8000 system.  Detailed procedures are provided in the following chapters.

1. Verify that the installation and site requirements are met.  Refer to 
Section 2.1 Site Recommendations on page 4-3 in this chapter.

2. Install the voice blade.

This step is only required if you are replacing an existing voice blade.  Refer 
to Chapter 6 Hardware.

3. Establish a connection to the phone system.
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4. Set up the phone system.

Refer to  Chapter 13 Section 3.1 Configuring TCP/IP on page 14-3 and 
Chapter 3 Section 1.2 Configuring Internet Explorer on page 3-1.

5. Set up the UM8000 software.

Refer to Chapter 9 Section 5 Setting Up the UM8000 Software on page 9-13

6. Set up remote maintenance.

Refer to Chapter 14 Remote Maintenance.

7. Set up optional features:

For information on E-mail integration, refer to Chapter 13 E-mail Integration.

For information about installing and configuring Visual Messaging, refer to 
the VMA Installation Guide.

8. Optionally: 

• Upgrade version

• Migrate OS/2 system

9. Backup the voice messaging data.

For information, refer to Chapter 15 Backing up and Restoring UM8000.

10. Reset the default administrator user name and password. For more 
information, refer to the Configuring UM8000 section.
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5Starting and Stopping the Voice Messaging 
Software and System

SECTION  1 OVERVIEW

Stop and start the voice messaging software using the Web Administration 
Console.

Some procedures require stopping the voice messaging software. Other 
procedures require stopping and restarting the voice messaging software 
to apply configuration changes. Whatever the reason, use the following 
procedure to stop or start the voice messaging software.

SECTION 2 STOPPING/STARTING USING THE WEB ADMINISTRATION 
CONSOLE

To start or stop the voice messaging software using the Web 
Administration Console, perform the following procedure:

1. Log on to the Web Administration Console.

2. Click Server Control.

3. Click Stop to stop the voice messaging software, or Start to start the 
voice messaging software. 

NOTE

. The voice messaging software might take a few minutes to shut down 
completely.
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SECTION  1 CD-VM00 BLADE (VOICE MAIL AND SERVER)

1.1 Description

The CD-VM00 blade is a complete, self-contained unit that plugs 
directly into the UM8000 telephone system.  This blade is a PC 
platform that contains data storage for voice recording and 
application software supporting a maximum of 16 ports.  Only one 
CD-VM00 can be installed per SV8100. However, eight may be 
installed for SV8300.

The board includes a compact flash disk that provides storage for 
the voice messaging software, messages, and recordings. 
Software required to run the voice messaging system is 
pre-installed on the disk.  Figure 6-1 CD-VM00 Blade–Top View on 
page 6-2 shows the top view of the CD-VM00 voice board.

1.2 Functions

A digital signal processor/voice processing section handles the 
following functions:

• DTMF detection

• DTMF generation

• General tone detection

• FAX CNG tone detection

• PCM compression for audio recording/playback

• Automatic Gain Control (AGC)

• Two USB ports for USB keyboard support, database backup 
and software upgrades

• One 15-pin VGA connector for VHA monitor support
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SECTION 2 INSTALLATION

Figure 6-1  CD-VM00 Blade–Top View

Ethernet LEDs Flash Card

Memory

Battery
Active LED

Load Button

RJ-11/Serial

VGA Monitor

USB

RJ-45/10/100

Back Plane

APP LED

Busy LED

CF Active Drive LED

CAUTION

. When installing the blade, observe the following precautions to avoid 
static electricity damage to hardware or exposure to hazardous voltages.

. The CD-VM00 unit makes extensive use of CMOS technology and is 
very susceptible to static.  Handle with extreme care to avoid static 
discharge.

. Handle the drive and blade carefully to prevent damage. Do not drop 
the drive or apply pressure to it.

. DO NOT install a USB mouse. This is not supported and can cause 
unexpected behavior.
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Perform the following procedure to install the CD-VM00.

1. Wear a grounding strap while handling the CD-VM00 and DSP. Lay the 
components on a flat work surface.

2. Mount the CR-2032 battery with the + side up in the BATT slot on the CD-VM00. 
Refer to Figure 6-2 Install the CR-2032 Battery.   

3. To install the SO-DIMM memory on the CD-VM00 blade, insert the end with the 
brass connectors into the CN14 1 slot.  Then, push the other end down until  
both sides lock into place.  Refer to Figure 6-3 Install the SO-DIMM Memory.   

Figure 6-2  Install the CR-2032 Battery

Figure 6-3  Install the SO-DIMM Memory



Issue 8.0 UM8000

6 - 4 Hardware

4. Install the Compact Flash drive into slot CN7. Ensure the drive 
is fully seated in the slot.  Refer to Figure 6-4 Install the 
Compact Flash Drive on page 6-4.  

SECTION 3 LOAD PUSH-BUTTON SWITCH

The Load push-button switch on the CD-VM00 Blade provides the following function:  

3.1 To Reset CD-VM00 (APSU) to Default

To reset the CD-VM00, perform the following operation:

1. While the voice mail is running, hold the Load button for more than three 
seconds. This will reset the database and all voicemail to default.

Figure 6-4  Install the Compact Flash Drive

CAUTION

. Do not press the load button while the voice messaging system is running. This can 
corrupt the database. In addition, it shold not be pressed while the system is re-
booting. Pressing the load button while the system is rebooting resets the database to 
default. Do not press the load button more than once unliess you intend to reset the 
system to default.
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SECTION 4 LED INDICATIONS

The following table describes the LED indicators.

Table 6-1  LED Indicators

LED ID Color(s) Description Indication

Active Green

Off Power off.

On Reset.

Slow Flash
Board is running but not in sync 
with the chassis yet.

Fast Flash
Board is in sync with chassis and 
operating normally.

Busy Red

Off Power off or idle.

On Reset.

Flash

Indicates how many ports on the 
VM card are currently in use. 
Faster flash rates indicate heavier 
use.

Application Red/Green

Off Power off.

Solid Red/Green
(Yellow)

Reset.

Flashing Green
OS is running, application not 
started.

Solid Green Application running.

Solid Red Application problem.

CompactFlash 
Card Activity Red On

Indicates read/write activity on the 
CampactFlash card - controlled by 
the IDE controller.
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SECTION 5 CONNECTORS

The following sections go into detail on each of the user interfaces.

5.1 RS-232 Interface

An RS-232 interface is provided as a debug port to the CPU. The AMD Geode 
companion chip (CS5536) provides a serial port interface. The CS5536 is 
connected to an Intersil-Harris HIN202ECBN (or equivalent) RS-232 
transceiver providing a DTE interface (COM1) with the following signals: TD, 
RD, DSR, DTR and GND.

The CD-VM00 uses the same 6-pin modular jack as the DSX system.  A 
standard telephone line cord is used as the RS-232 cable.  A DB9 to 6-pin 
modular adapter is used on the device end of the cable.  Refer to Figure 6-5 
CD-VM00 DB9 to 6-Pin Modular RS-232 Adapter on page 6-6.

The pin connections of RS-232 signal pairs are symmetrical around the center 
line of the 6-pin modular connector. This signal layout permits the construction 
of a null serial cable by simply reversing one of the modular connectors on the 
serial cable line cord.

Figure 6-5  CD-VM00 DB9 to 6-Pin Modular RS-232 Adapter
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The cable used for a PC type DTE connection is a standard line cord shown in 
Figure 6-6 CD-VM00 RS-232 Serial Cable (DTE) on page 6-7. RS-232 Serial 
Cable (DTE).   

The connection for a DCE device uses the swapped line cord shown in Figure 
6-7 CD-VM00 RS-232 Serial Cable (DCE) on page 6-7. 

5.2 USB Interface

The CD-VM00 provides two USB interfaces. The connections to the USB 
interface are through a dual Type-A plug connector.  Some possible USB 
devices are the following:

• USB Keyboard

• USB Memory Device

Figure 6-6  CD-VM00 RS-232 Serial Cable (DTE)

Figure 6-7  CD-VM00 RS-232 Serial Cable (DCE)
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Per the USB spec, each USB device must start up in a low power mode 
drawing one unit (100mA) of current. The device may then request more 
power, up to 5 unit loads. For the APSU application, current draw of greater 
than one unit load per device shall not be allowed. To limit the current draw on 
the 5V received from the backplane, a dual power switch, TI TPS2046A or 
equivalent, shall be used to allow power enable control to the USB ports and 
to protect against short circuit events. If it becomes necessary to connect a 
high power USB device to the APSU, an externally powered USB hub could 
be inserted between the APSU and the high power device.

5.3 VGA Display Interface

The APSU card provides a VGA display interface through a standard DB-15 
connector. The AMD LX-800 Processor interfaces directly to the VGA 
connector. The VESA standard pin-out shall be used. Per the VESA standard, 
5V is required to be supplied to the connector in order to support the DDC I2C 
communication channel to the monitor only when the monitor is in sleep 
mode.  When the monitor is not in sleep mode, 5V is provided by the monitor 
power source.

On the APSU, 5V shall be provided to the VGA connector in a manner where 
it can be removed from the connector via component depopulation to reduce 
current draw on the 5V power supply should this feature not be needed.

5.4 10 BASE-T/100 BASE-TX Ethernet Interface

The APSU card provides a 10/100 Ethernet interface through an RJ-45 
connector. Some possible uses for the Ethernet port are the following:

• Unified Messaging (Email)

• Software Update

• Application Configuration

• Network Attached Storage (NAS)

The Via VT6107 Ethernet controller shall be used. It interfaces to the CPU 
over a 33 MHz PCI bus and connects directly to an Ethernet RJ-45 connector 
with built-in magnetic and LEDs. The RJ-45 connector pin-out is shown in 
Table 6-2 Ethernet Connector Pin-Out on page 6-9.
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Table 6-2  Ethernet Connector Pin-Out

View Pin No. Signal Note

1 Tx+

PIN1 ---- PIN8 2 Tx- 10BASE-T/100BASE-TX port 
(RJ-45 connector)

3 Rx+

4 NC

5 NC

6 Rx-

7 NC

8 NC
1           8
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7Setting Up Integration (SV8100/SV9100)

SECTION 1 OVERVIEW

This chapter describes setup and programming for integrating the SV8100 
telephone system and the voice messaging system.

SECTION 2 SETTING UP INTEGRATION

• Extensions must be installed and set up for each voice messaging 
port.

• Hunt groups, trunk routing, and call overflow must be programmed 
so that the proper calls are routed to the voice messaging system.

• Test the voice messaging system extensions for the integration. 
Confirm that the voice messaging extensions are configured properly 
to integrate with the voice server.

• Learn the telephone system tones, if necessary. Use the Global Tone 
Detect utility to configure the voice server to recognize the system 
tones.

SECTION 3 CONFIGURING INTEGRATION

Additional voice messaging system features are set up on the 
Administration Console screens:

• Easy Message Access

• Identified Subscriber Messaging

• Trunk Mapping for Transaction Boxes
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SECTION 4 PROGRAMMING

4.1 Basic Configuration 

Program/
Item No.

Description Required

10-09-01 DTMF and Dial Tone Circuit Setup 

11-07-01
Department Group Pilot Numbers choose Department 

Group and define Pilot Number 
X

11-12-42

Service Code Setup (for Service Access), Flash on Trunk 

Lines This code is used for Centrex Transfer using Digital 

voice mail ports. If this code starts with # then 45-01-05 

must be set to 0 (Off). 

14-01-22 Basic Trunk Data Setup – Caller ID to Voice Mail

14-02-10 Analog Trunk Data Setup – Caller ID

15-02-08 Pre-select/One Touch

15-02-26
Multiline Telephone Basic Data Setup, MSG Key Operation 

Mode 

15-03-01
Single Line Telephone Basic Data Setup - SLT Signaling 

Type set all Voice Mail ports to 0 (DP)
X

15-03-03
Single Line Telephone Basic Data Setup - Terminal Type set 

all Voice Mail ports to Special 
X

15-03-09
Single Line Telephone Basic Data Setup -Caller ID Function 

for External Module

15-07-01 Programmable Function Keys

16-01-01 Department Name

16-01-04 Hunting Mode

16-01-10 Enhanced Hunt Type

16-02-01

Department Group Assignment for Extensions put all Voice 

Mail ports in Group Number used in 11-07-01 and assign 

priorities

. When setting up hunt group priorities the VM ports 
must be assigned as port 1 = priority 1, port 2 = 
priority 2 and so on.  Failure to do this will cause the 
VM to answer but no audio will be heard.

X

20-02-09
System Options for Multiline Telephones - Disconnect 

Supervision 
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4.2 Class of Service

It is recommended the voice mail extensions be put in Station Class of 
Service No. 1.

20-08-05
Dial Preview, if screening a message using the Live Monitor 

feature and the user dials any digit the screening will stop if 

this is enabled for that phones class of service.

20-09-07
Call Queuing, turn off or on an extension ability to 
have calls queued if a call rings the extension when it 
is busy.

20-13-06
Automatic Off-Hook Signaling (Automatic Override),  
allows a busy extension to manually (0) or 
automatically (1) receive off-hook signals.

45-01-01
Voice Mail Integration Options, Voice Mail Department 

Group Number assign Group Number used in 11-07-01 
X

45-01-02 Voice Mail Integration Options, Voice Mail Master Name 

45-01-05

Voice Mail Integration Options, Message Wait When using 

Centrex Transfer from a voice mail port, then the following 

items must be considered: 

1) If the Feature Access Code starts with #, then set PRG 

45-01-05 to 0. 

2) When assigning the dial string in voice mail, one or more 

Pauses may be needed depending on what Telco needs. 

45-01-06
Voice Mail Integration Options, Record Alert Tone Interval 

Time 

45-02-01 Send DTMF tone or 6KD message, should be set 1. X

45-02-03 Send 51A Message, should be set 1. X

Program/
Item No.

Description Required
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4.3 Assign Trunks as Automated Attendant Trunks

Program/
Item No.

Description Required

22-01-04 
System Options for Incoming Calls - DIL No Answer Recall 

Time 

22-02-01 Incoming Call Trunk Setup 

22-04-01 Incoming Extension Ring Group Assignment 

22-07-01 DIL Assignment 

22-08-01 DIL/IRG No Answer Destination 

24-02-02 
System Options for Transfer - MOH or Ringback on 

Transferred Calls 

24-02-03 
System Options for Transfer - Delayed Call Forwarding 

Time 

80-03-01 DTMF Tone Receiver Setup  

80-04-01 Call Progress Tone Detector Setup  
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8Setting Up Integration (SV8300/SV9300)

SECTION 1 OVERVIEW

This chapter describes setup and programming for integrating the SV8300  
telephone system and the voice messaging system.

SECTION 2 SETTING UP INTEGRATION

Several tasks are required to integrate UM8000 with the phone system. 
Use the phone system programming interface (either a CAT phone or a 
SV8300 PCPro) to enter the phone system programming commands 
below. Before setting up the integration, the UM8000 needs to be defined 
with CM 05>AABB>70.

Follow all procedures in this section in the order presented.

2.1 Assign Extension Numbers to Voice Messaging Ports

Assign extension numbers to the voice messaging ports. The 
UM8000 blade occupies ports AABB01 to AABB08 for an 8-port 
system, and ports AABB01 to AABB16 for a 16-port system.        

Command Code: 1000

First Data: AABBXX
Where AA = Chassis,
BB = Slot,
XX = Port.

Second Data: Fx-xxx
Where F specifies a digital extension and 
<x-xxx> is the voice messaging port extension 
number.

NOTE

. Repeat this command for each port on the UM8000 blade.
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2.2 Enabling Digital Voice Messaging Support

1. Enable AAInfo for incoming calls.   

2. Enable CCIS for incoming calls.   

3. Enable AAInfo for transferred calls.   

4. Enable CCIS for MWI.   

5. Link VMS soft key feature and expand AAINFO.   

Command Code: 08

First Data: 702

Second Data: 0

Command Code: 08

First Data: 703

Second Data: 0

Command Code: 08

First Data: 704

Second Data: 0

Command Code: 08

First Data: 706

Second Data: 0

Command Code: 08

First Data: 710

Second Data: 0
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2.3 Assign Voice Messaging Ports as Digital Voice Messaging Ports

Designate all voice messaging ports as digital voice messaging ports.       

2.4 Setting Up the UCD Hunt Group

1. Create a phantom extension number that will be the UCD pilot (master) 
number.   

2. Link the UCD pilot number to the first digital voice messaging extension.   

Command Code: 1324

First Data: x-xxx
Where <x-xxx> is the voice messaging port 
extension number.

Second Data: 0

NOTE

. Repeat this command for each port on the UM8000 blade.

Command Code: 11

First Data: xxxx
Where <xxxx> is a virtual port 
number.

Second Data: x-xxx
Where <x-xxx> is the UCD pilot 
extension

Command Code: 170

First Data: x-xxx
Where <x-xxx> is the UCD pilot 
extension number.

Second Data: x-xxx
Where <x-xxx> is the first digital voice 
messaging extension number.
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3. Link the first digital voice messaging extension number to the second 
digital voice messaging extension number, the second to the third, and 
so on.      

4. Assign the phantom extension number to the UCD pilot (master) 
number.   

5. Assign all UCD numbers to UCD group number 00.        

Command Code: 170

First Data: x-xxx
Where <x-xxx> is the first digital voice 
messaging extension number.

Second Data: x-xxx
Where <x-xxx> is the second digital 
voice messaging extension number.

NOTE

. Repeat this command, chaining each voice messaging extension to the next 
voice messaging extension. When you reach the last voice messaging 
extension number, link it back to the UCD pilot extension number created in 
Create a phantom extension number that will be the UCD pilot 
(master) number. (page 8-3).

Command Code: 171

First Data: x-xxx
Where <x-xxx> is the UCD pilot 
extension number.

Second Data: 1

Command Code: 172

First Data: x-xxx
Where <x-xxx> is the extension 
number.

Second Data: 00

NOTE

. Repeat this command for each voice messaging extension number and 
for the UCD pilot (master) number.
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6. Make busy the UCD pilot extension number.   

7. Assign the UCD pilot (master) number to the tenant number.   

2.5 Enabling the Automated Attendant
To use the voice messaging system as an automated attendant, program the
phone system to send external calls to the UCD pilot (master) extension.

2.6 Setting Up Call Forward on Busy or Ring-No-Answer
To forward calls to the messaging system on busy or ring-no-answer, program
the individual extensions to forward calls to the UCD pilot (master) extension.  

2.7 Enabling Busy Greetings

1. Log on to the Web administration console, then go to Subscribers > 
Subscriber Template > Greetings.

2. Select Enable busy greeting.

3. Click Save.

Command Code: E50

First Data: x-xxx
Where <x-xxx> is the UCD pilot 
extension number.

Second Data: 0

Command Code: 5115

First Data: 01

Second Data: x-xxx
Where <x-xxx> is the UCD pilot 
extension number.

NOTE

. To avoid creating a call forwarding conflict between the phone system and the 
messaging system, see About feature compatibility.
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2.8 Enabling Easy Message Access

Easy message access, also called direct message retrieval, is a feature that 
lets subscribers sign in quickly to the messaging system when dialing from 
their own extension. With this feature enabled, a subscriber who dials the 
messaging system is immediately asked to enter a security code without 
having to enter a personal ID.

Easy message access is enabled by default for all subscribers.

However, this feature can be enhanced by configuring a line key on each 
subscriber’s phone that can be pressed to dial the messaging system 
automatically. To do this, program the phone system to allocate a key on each 
subscriber’s phone to dial the UCD pilot number.

2.9 Disabling Easy Message Access

1. Log on to the Web administration console, then go to System  →  
Switch  →  Switch Information.

2. In the Integration options field, type EMA=0.

3. Click Save.

2.10 Enabling Automatic Subscriber-to-Subscriber Messaging in 
Secured Mode

By default, automatic subscriber-to-subscriber messaging is enabled in 
unsecured mode for all subscribers. To enable this feature in secured mode, 
do this procedure.

1. Log on to the Web administration console, then go to System  →  
Switch  →  Switch Information.

2. In the Integration options field, enter ISM=2.

3. Click Save.

2.11 Setting Up Message Waiting Indication

By default, message waiting indication is enabled for all subscribers. Use the 
following procedure to verify MWI settings.

1. Log on to the Web administration console, then go to System  →  
Switch  →  MWI.



UM8000 Issue 8.0

Installation Manual 8 - 7

2. Confirm that the On (activation) code and Off (deactivation) code 
fields contain an X.

3. Click Save.

2.12 Setting Up Automatic Number Identification (ANI)

To use ANI, you must activate the MF receiver built-in to the SV8300 CPU. 
Refer to the phone system documentation for details on setting up ANI.   

The phone system is now configured for basic digital integration.

2.13 Set the IP Address Information for the UM8000

1. Set the IP address for the UM8000   

2. Set the Subnet Mask for the UM8000   

3. Set the Default Gateway for the UM8000   

NOTE

. Setting up ANI overrides the Gather phone number call screening option, which asks 
callers to manually enter their phone number before routing the call.

Command Code: EE1

First Data: AABB
Where AA = Unit, BB = Slot

Second Data: XXX.XXX.XXX.XXX
Where X specifies the IP address.

Command Code: EE2

First Data: AABB
Where AA = Unit, BB = Slot

Second Data: YYY.YYY.YYY.YYY
Where Y specifies the Subnet Mask.

Command Code: EE3

First Data: AABB
Where AA = Unit, BB = Slot

Second Data: ZZZ.ZZZ.ZZZ.ZZZ
Where Z specifies the Default 
Gateway.
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2.14 Set the UM8000 License that are Loaded in the SV8300

1. Set the licensed amount of UM8000 FAX ports   

2. Set the licensed amount of UM8000 View Apps (View Mail/View FAX) 
Clients   

3. Set the licensed amount of UM8000 Multi-Language   

Command Code: EE0

First Data: AABB044
Where AA = Unit, BB = Slot,
044 = FAX ports

Second Data: 000 - 999
Amount of FAX ports license loaded 
in the SV8300 to enable in the 
UM8000.

NOTE

. System ports can not be set to fax-only.

Command Code: EE0

First Data: AABB046
Where AA = Unit, BB = Slot,
046 = View Apps Clients

Second Data: 000 - 999
Amount of View Apps Client license 
loaded in the SV8300 to enable in the 
UM8000.

Command Code: EE0

First Data: AABB047
Where AA = Unit, BB = Slot,
047 = Multi-Language

Second Data: 000 - 999
Amount of Language license loaded 
in the SV8300 to enable in the 
UM8000.
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4. Set the licensed amount of UM8000 Hospitality Languages 

5. Set the licensed amount of UM8000 TTS Languages   

To verify the licenses available on the SV8300, use the following:

F88>.....................used/available
F88>043:UMS PORT :0004/0004-
F88>044:UMS FAX PORT :0004/0004-
F88>045:UMS TTS PORT :0000/0000-
F88>046:UMS CLIENT :0040/0040-
F88>047:UMS LANGUAGE :0003/0003-
F88>048:UMS HOSPI LANG :0000/0000-
F88>049:UMS TTS LANG :0000/0000-

044-049 can be defined with the EE0 command.
043 is automatically set when the extensions are configured on the board.

SECTION 3 SETTING UP SOFT KEYS

Use the phone system programming interface (either a CAT phone or a SV8300 
PCPro) to enter the phone system programming commands.

3.1 Enabling Soft Key Call Screening

Command Code: EE0

First Data: AABB048
Where AA = Unit, BB = Slot,
048 = Hospitality Languages

Second Data: 000 - 999
Amount of Hospitality Languages 
license loaded in the SV8300 to 
enable in the UM8000.

Command Code: EE0

First Data: AABB049                                
Where AA= Unit, BB= Slot
049 = TTS Languages

Second Data: 000 - 999
Amount of TTS Languages license 
loaded in the SV8300 to enable in the 
UM8000.



Issue 8.0 UM8000

8 - 10 Setting Up Integration (SV8300/SV9300)

Enable soft key call screening systemwide.   

3.2 Enabling the Voice Messaging Ports for Soft Keys

Enable all voice messaging ports for soft keys.        

SECTION 4 SETTING UP LIVE RECORD

A subscriber can record phone conversations using their phone or using ViewMail. 

• To record conversations using ViewMail, a barge-in code and executive override 
must be configured on the phone system, and call forward busy must be 
disabled on each phone extension recording from ViewMail. A barge-in code is 
a key sequence that the phone system dials to activate executive override (or 
silent monitor) to begin the recording. See your phone system documentation 
for more information.

• To record conversations using a phone, the phone system and the subscriber’s 
extension must be configured properly. The procedures to do this are described 
later in this chapter.

While recording, a periodic beep is required by many local laws. To record from 
ViewMail, program the phone system to provide the periodic beep. To record from the 
phone set, configure the voice messaging system to provide the beep. The default is 
15 seconds. Entering 0 (zero) disables the beep. For instructions on how to set up the 
live record beep on the voice messaging system, see System Management Help.  

Command Code: 08

First Data: 715

Second Data: 0

Command Code: 1337

First Data: x-xxx
Where x-xxx is the voice messaging port 
extension number.

Second Data: 0

NOTE

. Repeat this command for each voice messaging extension on the 
UM8000 blade.

CAUTION



UM8000 Issue 8.0

Installation Manual 8 - 11

Non-Exclusive Hold (Station A places a call on hold and station B retrieves the 
held call) 

The following three tables show station operation, VM operation and created 
message files when Non-Exclusive Hold is performed.  

. The use of monitoring, recording or listening devices to eavesdrop, monitor, retrieve or 
record phone conversations or other sound activities, whether or not contemporaneous 
with transmission, may be illegal in certain circumstances under federal or state laws. 
Legal advice should be sought prior to implementing any practice that monitors or 
records any phone conversation. Some federal and state laws require some form of 
notification to all parties to a phone conversation, such as using a beep tone or other 
notification methods or requiring the consent of all parties to the phone conversation, 
prior to monitoring or recording the phone conversation. Some of these laws 
incorporate strict penalties.

Table 8-1  Call Hold-1: Station A Automatic Live Record

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) places 
the call on hold. 

Recording is paused Message file 1

3 Station A (automatic) 
retrieves the held call.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record

Table 8-2  Call Hold-1: Station A Manual Live Record

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call

Conversation is 
started.

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A places the call on 
hold.

Recording is paused. Message file 1
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Non-Exclusive Hold (Station A places a call on hold and station B retrieves the 
held call) 

The following four tables show station operation, VM operation and created message 
files when Non-Exclusive Hold is performed.  

4 Station A retrieves the held 
call.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record]

Table 8-3  Call Hold-1: Station A: Manual Live Record … Answering a recall 

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started.

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A places the call on 
hold.

Recording is paused. Message file 1

4 Station A answers the recall. Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record]

Table 8-4  Call Hold-2: Station A Automatic Live Record, 
Station B Automatic Live Record

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) places 
the call on hold. 

Recording is paused Message file 1

3 Station B (automatic) 
retrieves the held call.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record

Table 8-2  Call Hold-1: Station A Manual Live Record

Station operation VM operation Created 
message file
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Table 8-5  Call Hold-2: Station A Automatic Live Record, Station B Manual Live Record

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) places 
the call on hold.

Recording is paused. Message file 1

3 Station B retrieves the held 
call.

Conversation is 
started and recording 

is stopped.

Message file 1 
ends.

4 Station B presses the Record 
key.

Recording is started. Message file 2 
[Another file]

Table 8-6  Call Hold-2: Station A Manual Live Record, Station B Automatic Live Record

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started.

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A places the call on 
hold.

Recording is paused. Message file 1

4 Station B (automatic) 
retrieves the recall.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record]
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Call Transfer - All Calls (Station A makes a hook-flash and dials station B to 
transfer a call) 

 The following six tables show station operation, VM operation and created message 
files when Call Transfer-All Calls is performed.

Table 8-7  Call Hold-2: Station A Manual Live Record, Station B Manual Live Record

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started.

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A places the call on 
hold.

Recording is paused. Message file 1

4 Station B retrieves the held 
call.

Conversation is 
started and recording 

is stopped.

Message file 1 
ends.

5 Station B presses the Record 
key.

Recording is started. Message file 2 
[Another file]

Table 8-8  Call Transfer: Station A Automatic Live Record, 
Station B Automatic Live Record

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) makes 
a hook-flash and dials station 
B number.

Recording is paused. Message file 1

3 Call is terminated to station B 
(automatic)

Recording is paused. Message file 1

4 Station B (automatic) 
answers.

Conversation and 
recording are re-

started.

Message file 1 
[Continuous Live 

Record]
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Table 8-9  Call : Station A Automatic Live Record, 
Station B Manual Live Record)   

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) makes 
a hook-flash and dials station 
B number.

Recording is paused. Message file 1

3 Call is terminated to station B. Recording is paused. Message file 1

4 Station B answers. Conversation is 
started and the 

recording is stopped.

Message file 1 
ends.

5 Station B presses the Record 
key. Recording is started. Message file 2 

[Another file].

Table 8-10  Call Transfer - All Calls: Station A Manual Live Record, 
Station B Automatic Live Record

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A makes a hook-flash 
and dials station B number.

Recording is paused. Message file 1

4 The call is terminated to 
station B (automatic).

Recording is paused. Message file 1 
ends.

5 Station B (automatic) 
answers.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record]
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Table 8-11  Call Transfer - All Calls: Station A Manual Live Record, 
Station B Manual Live Record

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A makes a hook-flash 
and dials station B number.

Recording is paused. Message file 1

4 The call is terminated to 
station B.

Recording is paused. Message file 1 
ends.

5 Station B answers.
Conversation is 

started and recording 
is stopped.

Message file 1 
ends.

6 Station B presses the Record 
key. Recording is started. Message file 2 

[Another file]

Table 8-12  Call Transfer failed: Station A Automatic Live Record, Station B: No Answer

Station operation VM operation Created 
message file

1 Station A (automatic) answers 
an incoming call.

Conversation and 
recording are started.

Message file 1

2 Station A (automatic) makes 
a hook-flash and dials station 
B number.

Recording is paused. Message file 1

3 Station A (automatic) makes 
a hook-flash, or answers the 
recall.

Conversation and 
recording are 

restarted.

Message file 1 
[Continuous Live 

Record]
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Under the following conditions, Continuous Live Record is not provided (cannot be 
provided).

• The caller is a station.

• The transfer destination is a trunk (tandem connection) 

• When transfer destination answers the held call or transferred call, it cannot seize 
a CFT trunk or IP-PAD. 

• The Record End Key is pressed before Call Hold/Call Transfer to stop the 
recording.

• Destination of Call Hold/Call Transfer is not set Automatic Live Recording. (Even if 
it promptly operates Live Record by hand, this won't be changed.)

* In these cases, recording is stopped as usual, and Continuous Live Record is not 
provided.

Table 8-13  Call Transfer failed: Station A Manual Live Record, 
Station B: No Answer

Station operation VM operation Created 
message file

1 Station A answers an 
incoming call.

Conversation is 
started.

-

2 Station A presses the Record 
key.

Recording is started. Message file 1

3 Station A makes a hook-flash 
and dials station B number.

Recording is paused. Message file 1

4 Station A makes a hook-flash, 
or Station A answers the call.

Conversation and 
recording are re-

started

Message file 1 
[Continuous live 

record]

NOTE

. The PBX must provide the necessary signaling for all of the described capabilities to 
work properly. Continuous Live Record requires SV8300 R6 or later. Desktop client 
Live Recording via Barge-in is not supported.
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4.1 Configuring Live Record on the Phone System

1. Enable the live record beep.   

2. Enable automatic live record systemwide, optional.       

3. Enable automatic live record for trunk calls, optional.   

4. Enable continuous live record system wide, optional (PBX Rev 6 or 
greater)

Command Code: 08

First Data: 109

Second Data: 0

Command Code: 08

First Data: 141

Second Data: 0
Where 0 enables automatic live 
record for systemwide and
1 disables automatic live record 
systemwide.

NOTE

. Automatic live record is supported only with release transfers.

Command Code: 3522

First Data: xx
Where <xx> is the trunk route 
number.

Second Data: 0
Where 0 enables automatic live 
record for systemwide and
1 disables automatic live record 
systemwide.

Command Code: 08

First Data: 1023

Second Data: 0
Where 0 enables Continuous live
record system wide and
1 disables it



UM8000 Issue 8.0

Installation Manual 8 - 19

5. Enable automatic live record for ISDN trunks, optional.   

4.2 Configuring Live Record on a Subscriber’s Extension

Do this procedure for each subscriber extension that will use live record.

1. Enable message waiting service for the extension.   

2. Set the Prime Line for the extension.   

3. Assign live record line key functions.    

Command Code: 7613

First Data: xxx
Where <xxx> is the digit conversion 
block number.

Command Code: 1303

First Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.

Second Data: 0

Command Code: 93

First Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.

Second Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.

Command Code: 9000

First Data: x-xxx, yyy
Where <x-xxx> is the subscriber’s 
extension number and
<yyy> is the line key.

Second Data: F1091
Where F1091 = Record.
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4. Enable automatic live record for the extension, if the subscriber wants it.   

4.3 Configuring Live Record on UM8000

By default, live record is disabled for subscribers in the default subscriber 
template and the maximum recording time for live record is 300 seconds, or 
five minutes. Use the following procedure to change the default  settings.

1. Log on to the Web administration console, then go to Subscribers → 
Subscriber Template  →  Live Record.

2. Select Enable live record.

Command Code: 1323

First Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.

Second Data: 0
Where 0 enables automatic live 
record for the extension and
1 disables automatic live record for 
the extension.
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3. In the Maximum record time field, specify the recording time in 
seconds.

4. Click Save.

5. If necessary, enable live record for any previously existing subscribers. 
The template change only affects new subscribers added to the 
messaging system.

SECTION 5 SETTING UP LIVE MONITOR

Subscribers can listen to a message as it is being recorded in their mailbox by using 
the live monitor feature. To monitor messages using a phone, the phone system and 
the subscriber’s extension must be configured properly. Use the phone system 
programming interface (either a CAT phone or a SV8300 PCPro) to enter the phone 
system programming commands.

5.1 Enable Live Monitor on the Phone System

Enable live monitor for the service restriction class.   

5.2 Configuring Live Monitor on a Subscriber’s Extension

Do this procedure for each subscriber extension that will use live monitor.

1. Set the live monitor mode for the subscriber’s extension.    

NOTE

. If Save Live Record in inbox is not checked, the Live Record will not 
be retained unless the user addresses the message during the call by 
dialing the intended recipient’s voice mail number

Command Code: 15186

First Data: x-xxx
Where <x-xxx> is the service restriction class.

Second Data: 0
Where 0 enables live monitor and
1 disables live monitor systemwide.

Command Code: 1226

First Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.
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2. Enable live monitor pickup.   

3. Assign the live monitor line key function.        

5.3 Enabling Live Monitor on UM8000

By default, live monitor is disabled for subscribers in the subscriber template. 
To enable live monitor in the subscriber template, use the following procedure.

1. Log on to the Web administration console, then go to Subscribers → 
Subscriber Template  →  Access Options.

2. Under Administration, select Enable Live Monitor.

3. Click Save.

4. Enable live monitor for any previously existing subscribers.

Second Data: 0
Where 0 = automatic mode,
1 = manual mode and
3 = off.

Command Code: 1227

First Data: x-xxx
Where <x-xxx> is the subscriber’s 
extension number.

Second Data: 3

Command Code: 9000

First Data: x-xxx, yy
Where <x-xxx> is the subscriber’s 
extension number and
<yy> is the line key.

Second Data: F5024

NOTE

. After programming is finished, the user at the extension must go 
off-hook (press the Speaker button), then press the key that was 
programmed for live monitor in step 3. The LED will turn red and live 
monitor is ready for use.
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9Configuring UM8000

SECTION 1 OVERVIEW

After the UM8000 blade is installed, the next step is to configure the voice 
messaging system and the SV8100/SV8300 phone system to 
communicate with each other.

SECTION 2 STARTING THE UM8000 FOR THE FIRST TIME

To start the UM8000 for the first time, make the required settings and 
license agreements before starting the application.  To access settings 
options and license agreements, connect to the Web Administration 
Console (WAC) using an internet browser.

If the license agreements are not accepted, the application cannot start.   

The following procedure provides instructions for starting the UM8000 for 
the first time:

1. First determine the IP address of the voice mail by checking program 
10-55-01 (this may be different for your switch, please see your 
switch documentation for details) for the slot where the blade is 
installed.

2. Start your internet browser and enter the IP address followed by 
/admin in the URL window.  Alternately, you can enter CM 
EE1>0105> for SV8300.

For example:  172.16.0.100/admin.

3. Press <ENTER>.

NOTE

. If the voice mail database is defaulted, this procedure must be repeated.
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4. If prompted with a certificate warning, accept the certificate and choose to 
continue to web page.  Then log into the WAC with the user name: $nec. 
No password is required. 

Figure 9-1  UM8000 Login
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5. You are prompted to accept the third party software license agreement.

Figure 9-2  Third Party Software License Agreement
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6. Choose the phone system where the voice mail is to be installed. 

Figure 9-3  UM8000 Switch Information
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Figure 9-4  UM8000 Integration Options
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7. Set the extension numbers that are assigned to the voice mail in program 
11-02-01.  Select  Edit All.  Enter the extension number for each voice mail port, 
then click Save. 

Figure 9-5  Entering Switch Extensions for Voice Mail Ports, Screen 1
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Figure 9-6  Entering Switch Extensions for Voice Mail Ports, Screen 2
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8. To register the equipment at this time, enter the registration information on the 
Product Registration Form screen.  The voice mail must have access to the 
internet for the registration to be successful.  You can also choose not to register 
at this time or to be reminded in seven days.

Figure 9-7  Product Registration Form
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9. You are now logged into the WAC, but the application is not yet started.

Figure 9-8  System Information
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10. Start the application by going to Server Control and clicking on the Start icon.

SECTION 3 CONFIGURING THE VOICE MESSAGING SYSTEM

Configuring the voice messaging system is managed using two tools: the 
Maintenance Menu and the Web administration console. The Maintenance Menu is a 
graphical user interface that minimizes the need to enter lengthy commands at the 
command line prompt.

• Maintenance Menu – Use the Maintenance menu to specify network DNS 
configuration settings, change the administrator password, and for general tone 
detection.

• Web administration console – Use the Web administration console to set 
hospitality (Property management system - PMS) settings, e-mail integration 
settings, add/remove language packs, extension remapping, trunk remapping, 
update licensing information, specify switch integration information, and much 
more. Refer to System Management Help for details about other functionality 
available in the Web administration console.

Figure 9-9  Server Control Start Icon
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SECTION 4 BEFORE SHIPPING THE VOICE MESSAGING SYSTEM

Resellers who are assembling voice messaging systems for delivery to customers 
must reset the third-party licensing agreements. This enables the customers to accept 
the licensing for third-party software that is installed with the voice messaging system. 

4.1 Resetting Third-Party Licensing Agreements

To reset:

1. Start PuTTY.

2. Log on as admin.

3. Type the password, voicemail, then press <ENTER>.

The Main menu appears.

4. Choose 2-Maintenance, then press <ENTER>.

The Maintenance menu appears.

5. Choose 3-Command prompt, then press <ENTER>.

6. Type sudo  /opt/vmail/bin/prepare_system <ENTER>. 

The first time the client starts the Web administration console, the licensing 
agreements are displayed.

4.2 Defaulting the UM8000 Database

To default the UM8000 database:

1. Start PuTTY and connect to the UM8000 IP Address set in 
Program10-55-01 (this may be different for your switch, please see your 
switch documentation for details).

The login prompt appears.

2. Type admin <ENTER>.

3. Type the password: voicemail <ENTER>.

The Main menu appears.

CAUTION

. Law requires that end-users accept the End User License Agreement for software 
installed on their systems.



Issue 8.0 UM8000

9 - 12 Configuring UM8000

4. Choose 2 Maintenance.

The Maintenance menu appears.

5. Choose 3 Restore default database.

6. If the voice mail application is running you will be prompted to stop it.

7. Choose Yes to stop the voice mail application.

When finished the system will prompt you to exit and restart the voice mail 
application.

8. Choose 0 Return to previous menu.

The Main menu appears.

9. Choose 3 Control.

The Server Control menu appears.

10. Choose 1 Start Voice mail server.

11. Choose 0 Return to previous menu.

The Main menu appears.

12. Choose 0 to log out of maintenance menu.
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SECTION 5 SETTING UP THE UM8000 SOFTWARE

After installing and connecting to the UM8000 blade, configure the voice blade and 
voice messaging software features.

5.1 Configuring Network Setup

The following network information is required to configure the network setup. 

Use the following procedure to specify the network setup.

5.2 Specifying the Network Setup

The IP address for the voice mail is assigned in chassis programming 
10-55-xx (this may be different for your switch, please see your switch 
documentation for details).  At default this address is 172.16.1.xxx, where .xxx 
varies depending on the slot where the CD-VM00 is installed.  Starting with 
slot 1 this is .100, slot 2 is .101, slot 5 is .104 and so on.

The DNS server IP Address, Host Name and Domain Name are all that can be 
configured from the Maintenance Menu.

To specify the setup:

1. Start PuTTY.

The login prompt appears.

2. Type admin <ENTER>.

The following network information is required to configure 
the network setup.

Host name or IP address

Domain name

Primary DNS IP address

Secondary DNS IP address

TCP/IP
Minimum required to provide access to Web administration 
console and Maintenance menu (PuTTY).

IP address

Subnet mask

Default gateway
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3. Type the password: voicemail <ENTER>.

The Main menu appears.

4. Choose 1 Configuration, then OK.

The Configuration page appears.

5. Choose 1 Network setup, then OK.

6. The Network setting page appears.

7. Choose 1 Host name, then OK.

The Host name page appears.

8. Type the Host name, the choose OK.

The Network setting page reappears.

9. Choose 2 Domain name, then OK.

The Domain name page appears.

10. Type the Domain name, then choose OK.

The Network setting page reappears.

11. Choose 3 Primary DNS, then OK.

The Primary DNS page appears.

12. Type the DNS server IP address, then choose OK.

The Network setting page reappears.

13. Choose 4 Secondary DNS, then OK.

The Secondary DNS page appears.

14. Type the DNS server IP address, then choose OK.

The Network setting page reappears.

5.3 Setting Up UM8000 Date and Time

The UM8000 Mail automatically synchronizes its time and time zone with the 
phone system time on boot up.  Manual adjustments on the voice mail are not 
needed or available.
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5.4 Changing Administrator Password and Creating a New User

5.4.1 Changing the Password

To change admin password, use the following procedure.

1. Start PuTTY.

2. Log in as Admin <ENTER>.

3. On the Main menu, choose 2-Maintenance, then press <ENTER>.

The Maintenance page appears.

4. On the Maintenance menu, choose 2-Set admin password, then 
press <ENTER>.

The Set admin password page appears.

5. Type the new password, then press <ENTER>.

6. Retype the new password., then press <ENTER>.

An alert message appears stating that the password has been 
changed.

7. Click OK or press <ENTER> to return to the Maintenance menu.

8. On the Maintenance menu, choose 0-Return to previous menu, 
then press <ENTER> to return to the Main menu.

5.4.2 Creating a New User

To create a new WAC user for the voice messaging system, perform 
the following procedure:

1. Start the Web administration console.

2. Under Subscribers, click Subscribers.

The Subscriber profile page appears.

3. Click the Add icon to create a new subscriber.

The Add subscriber page appears. 

4. Make sure that the New subscriber radio button is checked.

5. Click Add.

The Add subscriber page resets. Close the page.

6. On the Subscriber profile page, choose the Enable subscriber as 
system manager check box.

7. Click the Save icon.

8. The new subscriber now has system manager permissions.
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SECTION 1 OVERVIEW

Presence allows users to record greetings that are specific to their status, 
so the callers can hear meaningful information about the subscriber 
availability.

There are two types of presence engines available in UM8000. They are 
as follows:

• NEC UC Desktop Suite

• Internal UM8000 engine

SECTION 2 NEC UC DESKTOP SUITE

NEC UC Desktop Suite delivers various Unified Communications 
capabilities such as call and presence management, to the user desktop. 
When integrated with UM8000, the subscriber greetings are automatically 
activated based on the UC Desktop presence, and users can use the TUI, 
Web Mailbox Manager (WMM), or Mobile Web Mailbox Manager (MWMM) 
to set their UM8000 and UC Desktop presence.

SECTION 3 INTERNAL UM8000 PRESENCE

The internal UM8000 presence engine allows administrators to define the 
available subscriber presence greetings, and allows the users to select the 
appropriate presence greeting from either the TUI, WMM, or MWMM.

NOTE

. NEC UC Desktop Suite is sold seperately and is only available for 
integrations using an SV8100.
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SECTION 4 CONFIGURING PRESENCE

Configuring Internal presence settings

1. In the Web Administration Console (WAC), navigate to System -> 
Configuration > Presence Greetings.

2. Select Internal from the Presence Integration drop down

3. Using the Default drop down under Presence Greetings, select the greeting 
that will be used for the default greeting.

4. Associate the desired greeting in the Presence column with the TUI DTMF tone 
in the Greeting column.

5. Check any the boxes under Presence integration options to allow users to 
override Alternate greetings and Busy greetings.

6. Click the Save icon.

Configuring UC Desktop Suite  presence settings

1. In the Web Administration Console (WAC), navigate to System -> Configura-
tion > Presence Greetings.

2. Select UC Desktop Suite from the Presence Integration drop down

3. Using the Default drop down under Presence Greetings, select the greeting 
that will be used for the default greeting.

4. Associate the desired greeting in the Presence column with the TUI DTMF tone 
in the Greeting column.

5. Check any the boxes under Presence integration options to allow users to 
override Alternate greetings and Busy greetings or to allow users to set greeting 
expiration dates and times.

6. Click the Save icon.

Defining the Default Presence Setting

1. Navigate to Subscribers -> Subscriber Template -> Profile.

2. Select the default presence engine in the Presence Integration dropdown.

3. Click the Save icon.

NOTE

. The Internal presence engine does not support allowing users to set a date 
and time for a greeting to expire.
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Setting an Individual User's Presence Engine

1. Navigate to Subscribers -> Subscribers -> Profile.

2. Search for the user name by clicking the Search icon.

3. Set the desired presence engine in the Presence Integration field.

4. Click the Save icon.
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11Setting Up Visual Messaging Integration

SECTION 1 VISUAL MESSAGING OVERVIEW

Visual Messaging is a suite of applications that combines features of the 
voice messaging software, the telephone system, and a LAN. The Visual 
Messaging suite consists of ViewMail®, ViewCall® Plus, and ViewMail for 
Microsoft® Messaging. Visual Messaging subscribers can use their 
desktop workstations to access and manage voice messages. To install 
and set up a Visual Messaging application, perform the following setup 
steps.

Both the voice server and individual workstations must be set up for Visual 
Messaging to work. This chapter explains how to configure the voice 
messaging system. The next chapter explains how to configure 
workstations.

. All Visual Messaging Client installation files are located on the NTAC 
download site.

1.1 Setup Steps

1. Install the voice mail in phone system.

2. Connect the voice mail computer to the LAN.

See “Connecting the Voice Messaging Computer to a LAN,” on
page 11-2.

3. Install and set up the application on the workstations.

See Section 1 Visual Messaging Workstation Overview on page
12-1.
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SECTION 2 VISUAL MESSAGING HARDWARE AND SOFTWARE REQUIREMENTS 

Please refer to your operating system documentation for minumum system 

requirements.

SECTION 3 CONNECTING THE VOICE MESSAGING COMPUTER TO A LAN

Perform the following procedures to test the LAN connection to which the voice server 
is to be connected and to connect the voice server to the LAN. Consult the LAN 
administrator for more information on testing the LAN connection. This procedure 
assumes you have already set up the voice messaging computer for networking.

Visual Messaging uses TCP port 1024. You need to know the TCP port to allow 
access through a firewall.

To test the LAN connection

1. Use a network analyzer or a workstation that you know works properly with the 

Table 11-1  View App Client Support Table

View App 
Client

Supported 
Operating System

Supported Client 
Versions

Additional Information

View Mail for 
Microsoft 
Messaging 
(VMM)

Windows 7 
      (32/64-bit)
Windows 8.1

Outlook 2003
Outlook 2007
Outlook 2010
Outlook 2013

N/A

View Mail Windows 7 
      (32/64-bit)
Windows 8.1

N/A N/A

View Call Plus Windows 7 
      (32/64-bit)
WIndows 8.1

N/A Supported PIMs:
• Outlook 2003 or higher

View Fax Windows 7 
      (32/64-bit)
Windows 8.1

Outlook 2003
Outlook 2007
Outlook 2010
Outlook 2013

N/A

View Mail for 
Lotus Notes 
(VML)

Windows 7 
      (32/64-bit)
Windows 8,1

Lotus Domino 6.0 or 
higher

Supported Servers:
• Lotus Domino 6.0 or higher

View Mail for 
GroupWise 
(VMG)

Windows 7 
      (32/64-bit)
Windows 8.1

GroupWise 6.5 w/ SP1 
or higher

Supported Servers:
• GroupWise 6.5 or higher
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network. Connect the unit to the LAN hookup with the network cable that the 
voice messaging computer uses.

2. Confirm that the network analyzer or workstation can communicate with the 
network through the connection.

3. After a successful test, disconnect the network cable from the analyzer or 
workstation.

To connect the voice mail to a LAN

• Connect the network cable to the network port on the  voice mail unit.
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SECTION 4 SPECIFYING STATION NUMBERS FOR VIEWCALL PLUS

For ViewCall Plus to work correctly, the telephone system station numbers must be 
entered into the voice messaging system.

To specify station numbers in the voice messaging system

1. On the UM8000 Mail Administration web-console, select System  →  Switch  → 
Switch Extensions.

2. In the Station Number boxes, enter the appropriate voice mail station.

3. Click Save icon to write data.
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12Setting Up Visual Messaging Workstations

SECTION 1 VISUAL MESSAGING WORKSTATION OVERVIEW

This chapter provides instructions for installing and setting up Visual 
Messaging software on desktop workstations.

1.1 Workstation Requirements

• One of the following operating systems:

• Microsoft Windows 7 (32 or 64-bit)

• Microsoft Windows 8.1

• 10 MB of free hard disk space

. The UM8000 Mail Visual Messaging clients are not compatible with 
Windows 95, 98, or NT.

1.2 Set up Steps

1. Set up the TCP/IP network protocol on the Visual Messaging 
workstations. Refer to Section 2 Setting up the TCP/IP 
Network Protocol on page 12-2.

2. Install and set up Visual Messaging on the workstations.
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SECTION 2 SETTING UP THE TCP/IP NETWORK PROTOCOL

You must set up the protocol in any Visual Messaging application installed at a 
workstation. Visual Messaging workstations use TCP/IP as the communications 
protocol. Workstations on a LAN typically have:

• Microsoft client

• NIC drivers (software that runs the NIC)

• TCP/IP network protocols

The LAN administrator is usually responsible for LAN-related maintenance.

The following sections describe how to install and set up the TCP/IP drivers, and how 
to use Visual Messaging applications remotely with wide area networks (WANs) and 
the Internet:

To use Visual Messaging applications remotely (with TCP/IP), refer to Section 6.

To set up TCP/IP on the workstation, follow the vendor instructions included with your 
stack, and consult the examples in the following sections.

The following sections provide instructions for setting up TCP/IP on Visual Messaging 
workstations. Choose the appropriate workstation operating system:

• Windows 7 in Section 3 Setting up TCP/IP for Windows 7 and 8.1.

• Windows XP in Section 4 Setting up TCP/IP for Windows XP on page 12-2.

SECTION 3 SETTING UP TCP/IP FOR WINDOWS 7 AND 8.1

TCP/IP networking is installed by default when Windows 7 or 8.1 is installed. 
However, if you wish to check to ensure that it is installed and working properly, see 
Section 4 Testing the TCP/IP Setup on page 12-3.
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SECTION 4 TESTING THE TCP/IP SETUP

Use the PING software included with your TCP/IP stack to confirm that the 
workstation can exchange data with the voice messaging system.

. Remember when working at a Linux command prompt that Linux is case sensitive.

To use the PING utility

1. On the workstation, open an MS-DOS command prompt window.

2. Enter ping <IP address of the voice messaging system>, then 
press ENTER.

If you see a PING software reply message containing bytes received, the TCP/IP 
software is set up properly.

If the TCP/IP software is not set up properly, you get a message saying that the IP 
address could not be reached. There are several possible reasons for this:

• The workstation is not set up correctly. Repeat the setup procedure.

• The voice messaging system is not set up correctly. Confirm that the TCP/IP 
software is properly installed on the voice messaging computer.

• There is a problem with the network. Contact your LAN administrator.

• The cables may not be attached correctly and securely. Check that the cables 
are securely attached to the correct devices.

• You may not have restarted the computer. Close all files, shut down all 
applications, and restart the computer.

SECTION 5 USING VISUAL MESSAGING APPLICATIONS WITH WANS AND THE 
INTERNET

Visual Messaging clients or workstations can use TCP/IP to run Visual Messaging 
applications over the Internet or a wide area network (WAN). The following conditions 
are required to establish a TCP/IP connection between a remote workstation and the 
voice messaging system:

• The remote workstation is connected to the voice messaging system through a 
WAN, dial-up Internet service, or dedicated Internet connection.

• The LAN administrator has configured the network to enable remote 
connections.
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After these conditions are met, the remote workstation can access the voice 
messaging system.

To connect remotely to the voice messaging system

1. From the remote workstation, connect to the WAN or ISP using TCP/IP as the 
network protocol.

2. After the connection between the workstation and host is established, open the 
desired Visual Messaging application.
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SECTION 1 OVERVIEW

This chapter explains how to set up e-mail integration for the voice 
messaging system, and how to set up e-mail features for subscribers.

Subscribers can use text-to-speech technology to listen to e-mail 
messages by phone. E-mail message counts can be included in new 
message counts. All voice messages and faxes can be forwarded to 
e-mail inboxes.

The e-mail integration provides 24-hour access to e-mail from any 
touchtone phone. Standard protocols are used to access, read, and send 
e-mail messages on the voice messaging system. The protocols for 
integration include IMAP and MIME. 

The e-mail server must support the SMTP protocol for outgoing e-mail 
features to work properly.

SECTION 2 PROTOCOLS

2.1 E-mail Protocols

The following standard e-mail protocols ensure the successful 
transmission of e-mail messages:

• IMAP – Internet Message Access Protocol (IMAP) provides 
the voice messaging system access to e-mail inboxes. 

The voice messaging system uses IMAP to obtain e-mail 
message headers and body information from a variety of 
e-mail servers. This information is delivered to the 
text-to-speech engine to convert the text to audio format for 
playback.
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• MIME – Multipurpose Internet Mail Extensions (MIME) provides the 
voice messaging system the capability to read e-mail message header 
and body information. 

Multipart MIME messages enable the e-mail system to send enhanced 
versions of the message for messaging clients such as Lotus® Notes 
and Microsoft Outlook. Multipart MIME messages contain plain text 
messages that can be read to subscribers over the phone.

• POP3 – Post Office Protocol and Authenticated Post Office Protocol. 
POP3 is a standard internet protocol used for retrieving Internet e-mail 
and is used by the e-mail client to communicate with SMTP mail servers. 
With POP3 the user name and password are sent across the network in 
clear text. With APOP, the password is encrypted before being 
transmitted over the network to the SMTP mail server.

• SMTP – Simple Mail Transport Protocol (SMTP) allows the voice 
messaging system to send outgoing e-mail messages. The system 
forwards voice mail and faxes to the e-mail system, receives e-mail 
notification of new fax/voice mail, and uses voice mail features to reply to 
e-mail messages. SMTP can be configured to restrict the type of 
messages sent such as only allowing SMTP mail to be sent to other 
users on the same domain.

2.2 Subscriber E-mail Authentication Protocols

• PLAIN – PLAIN is a simple clear text password mechanism. The 
mechanism uses a user name and password to authenticate users.

• NTLM – NTLM is a challenge-response authentication protocol.  The 
server authenticates the client by sending an 8-byte random number, the 
challenge. The client performs an operation involving the challenge and 
a secret shared between client and server, e.g. a password. The client 
returns the 24-byte result of the computation. In fact, in NTLMv1 two 
computations are made using two different shared secrets and two 
24-byte results are returned. The server verifies that the client has 
computed the correct result, and from this infers possession of the 
secret, and hence the identity of the client.

• LOGIN – The LOGIN mechanism is a non-standard mechanism, and is 
similar to the PLAIN mechanism except that LOGIN lacks the support for 
authorization identities.

NOTE

. Text-to-speech does not support HTML encoded messages. If HTML tags 
are heard during message playback, the message is skipped. HTML 
messages must be encoded using multipart MIME for text-to-speech to 
work properly.
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SECTION 3 E-MAIL INTEGRATION SET UP

The following steps are required to set up the e-mail integration.

1. Configure the voice messaging system server.
Set up the information for the outgoing e-mail server connected to the voice 
messaging system.

2. Configure the e-mail server.
The e-mail server must be configured to properly integrate with the voice 
messaging system.  

Refer to the appropriate e-mail server documentation to configure the e-mail 
server.

3. Set up subscribers.
After the e-mail server and the voice messaging system are configured, 
configure subscriber mailboxes to access e-mail.

See NECNTAC Knowledge Base article 5451 for further information in 
troubleshooting steps.

SECTION 4 CONFIGURING THE E-MAIL SERVERS

The e-mail server must have SMTP, POP3 and IMAP enabled to use the e-mail 
integration.

To enable SMTP and IMAP refer to the e-mail server documentation or consult the 
system administrator about which settings are appropriate for the organization.  

4.1 Setting the E-mail Server Configuration

The following configurations must be set for the e-mail server.  

WARNING

. The e-mail administrator is required to configure the e-mail server.

WARNING

. The e-mail administrator is required to configure the e-mail server.

E-mail Server Required Protocols

Microsoft Exchange
IMAP, MIME, PLAIN, and LOGIN for 
outgoing messages

Lotus Notes Domino
IMAP, PLAIN, and LOGIN for outgoing 
messages
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4.2 Converting Existing Domino E-mail Files for Users

Set an Internet password for all existing users before converting any existing 
e-mail files. Use the following procedure to convert user e-mail files.

4.2.1 Converting Existing E-mail Files 

1. Log on to the Domino e-mail server as root user.

2. On the Windows taskbar, click Start  →  Programs  →  Lotus 
Application  →  Lotus Domino Administration.

3. Enter the Domino password.

The Domino Administrator console appears.

4. Click Console to open the Domino server command prompt.

The command prompt appears. Use one of the following set of 
commands to convert existing e-mail:

• To convert a single user, enter the following commands:

tell router quit
load convert -e mail\<mailfilename>.nsf
load convert -h mail\<mailfilename>.nsf
load router

Where <mailfilename> is the name of the user, follow these 
steps for each user to be converted.

• To convert all users in a directory, enter the following commands:

tell router quit
load convert -e mail\*.nsf
load convert -h mail\*.nsf
load router

5. Close the Domino Administrator.

6. Log off the Domino server.

The Domino server is now configured for e-mail integration.

GroupWise
IMAP4, PLAIN, and LOGIN for outgoing 
messages, SMTP Relay - Allow 
message relaying

E-mail Server Required Protocols
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SECTION 5 CONFIGURING THE VOICE MESSAGING SYSTEM

The e-mail server must be configured and connected to the voice messaging system 
before subscribers can use the e-mail integration.

The following e-mail server information is required to establish communications with 
the voice messaging system server:

• The IP address or exact name of the SMTP server.

• The SMTP port number.

5.1 Configuring the Voice Messaging System for E-mail Forwarding 
Integration 

1. Start the Web administration console.

2. Under System, click Configuration > E-mail settings.

3. In the Outgoing e-mail server field, enter the IP address of the outgoing 
e-mail server.

If the system is set up to recognize server names, enter the server name 
instead of the IP address.

4. In the Port field, enter the SMTP port for the e-mail server. The default 
port is 25.

If the Secure Sockets Layer (SSL) protocol is used, click the SSL check 
box.

5. In the Authentication field, select the authentication protocol used by the 
e-mail server.

6. Enter the user name.

7. Enter the password.

8. In the Global e-mail field, enter the common e-mail address used for all 
outgoing e-mail.

9. In the Display name field, enter the common display name used for all 
outgoing e-mail.

10. Click the Save icon.

The voice messaging system e-mail configuration is complete.

NOTE

. For SMTP forwarding to work, you will need to select Forward Voice Mail to 
EMail under Subscriber > Access Options and also define the subscriber email 
address under Subscribers > E-Mail
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Please refer to NECNTAC Knowlege Base article 5451 for further information on 
trubleshooting.



UM8000 Issue 8.0

Installation Manual 13 - 7

5.2 Configuring the Voice Messaging System for Text-to-Speech 
Integration

The following instructions assume that the UM8000 is licensed for at least one 
TTS port and the e-mail server is configured to support IMAP integration.  For 
information on configuring the e-mail server for IMAP integration refer to the 
manufacturer’s documentation for that application.

1. Start the Web administration console.

2. Go to Subscriber/Subscriber/E-mail.

3. Under E-mail reader (text to speech) choose the appropriate server 
type:

• IMAP for e-mail servers supporting IMAP integration, this is the preferred 
setting.

• POP3 for e-mail servers requiring a POP3 login.  Note this system does not 
support integration to POP3 accounts such as Gmail.  The POP3 protocol 
consists of many features including login (the login is supported by the 
UM8000).

4. Under Authentication Method choose the authentication method 
required by the e-mail server, Plain Text or NTLM.

5. Under Server Name enter either the server IP Address or if a DNS 
server is available enter the server name.  If a name is entered, refer to 
step 14. for setting the DNS server IP Address.

6. Under User Name enter the login name for the e-mail account to be 
accessed.

7. Under Port enter the port number required by the e-mail server. The 
industry standard port is 143.

8. If SSL authentication is required by the e-mail server check the SSL box.

9. Click on Save.

10. Go to Subscriber/Subscriber/Access Options.

11. Under E-mail check the Access e-mail messages from the 
messaging system box.

12. If desired, the voice mail can also include the number of new e-mails in 
the new message count.  To do this, check the Count e-mail messages 
in message totals box.

The system requires a mailbox user to enter an e-mail account password the 
first time they log into their mailbox.  This is in addition to their normal mailbox 
security code if enabled.
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The voice e-mail guides the user through entering the e-mail account 
password when logging into their mailbox.  This e-mail account password is 
stored until the voice mail is rebooted.  The user is required to enter this e-mail 
account password again.  If desired, the system can be configured so the user 
must enter the e-mail account password every time they log into their mailbox 
(refer to step 13.).  This setting is not recommended.

13. Under E-mail check the Ask for e-mail password box. This prompts the 
user to enter their e-mail account password every time they log into their 
mailbox.

If the e-mail server name is entered instead of an IP Address, the following 
settings allow the voicemail to differentiate between the e-mail server IP 
Address and the server name.  To do this, the local LAN administrator must 
supply, at a minimum, the Primary DNS Server IP Address.  Some sites may 
have a Primary and Secondary DNS server. If so, both are used.

The voice mail should be rebooted after configuring the DNS server IP 
Addresses.

14. Start Putty and connect to UM8000.

15. At login prompt, enter user name = admin and password = voicemail.

16. Choose 1 – Configuration.

17. Choose 1 – Network Setup.

18. Choose 3 – Primary DNS.

19. Enter the Primary DNS Server IP Address and select OK.

20. Choose 4 – Secondary DNS.

21. Enter the Secondary DNS Server IP Address and select OK.

22. Choose 0 – Return to Previous Menu.

23. Again choose 0 – Return to Previous Menu.

24. Choose 3 – Control.

25. Choose 2 – Restart messaging system server.  The voice mail 
application shuts down and reboots the board.

5.3 Configuring the E-mail Notification Template

1. Start the Web administration console.

2. Under System, click Configuration →   E-mail message template.

The e-mail message template page appears.
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3. The default language is automatically selected in the Language field. 
Select the a different language from the drop-down list.

4. Construct the notification template as needed.  The tags below can be 
used to insert information that the voice mail system dynamically 
determines for each message.
 

5. Click the Save icon.

6. Click Preview.

The voice messaging system e-mail configuration is complete.

Next step…
? Configure subscriber template e-mail settings.  Refer to Section 6 below.

SECTION 6 SETTING UP SUBSCRIBER MAILBOXES

After configuring the voice messaging system server and the e-mail server for e-mail 
integration, set up subscribers to access e-mail messages using the phone.

6.1 Setting Up the Default Subscriber Template

• [senderName] • Sender's name

• [senderPhone]  • Sender's phone

• [senderAccount] • Sender's account (only available if 
configured in subscriber transfer/
screening options) 

• [messageTimestamp] • Message received timestamp on 
the messaging system 

• [messageDuration] • Message length in seconds 

• [messageSize] • Message size in kilobytes 

• [messageFlag] • Message Special flags. Available 
message flags: PRIVATE and 
URGENT 

• [voicemailURL] • URL of the messaging system 

• [subscriberName] • Subscriber's name 

• [subscriberExtension] • Subscriber's extension 

• [notificationType] • Message notification type. Available 
notification types: voice, fax, 
message copy, forwarded voice, 
forwarded fax, forwarded fax with 
voice, reply fax, reply voice and IM 
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Configure the subscriber template for access to e-mail. The subscriber 
template is used to pre-configure new subscriber settings. Any existing 
subscribers must be configured individually.

To set up the default subscriber template, perform the following procedure:

1. Start the voice messaging system.

2. Start the Web administration console.

3. Under Subscribers, click Subscriber Template →   E-Mail.

4. In the Server type field, choose IMAP or POP3.

5. In the Server name field, enter the IP address for the voice messaging 
system. 

Choose authentication method Plaintext or NTLM.

6. If appropriate, make sure the Use SSL check box is checked, for SSL 
authentication.

7. When the SSL check box is checked, the port number 993 appears in 
the field. 

8. In the Port field, enter 143 for IMAP; 110 for POP3; or the appropriate 
value for the e-mail server. 

9. Click the Save icon.

NOTE

. For subscriber e-mail integration to work, the subscriber must have 
appropriate access options. Access to e-mail messages from voice mail 
or fax/voice e-mail forwarding or notification. This is for text-to -speech 
only and has nothing to do with SMTP forwarding.
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6.2 Setting Subscriber E-mail Options

Use the following procedure to change individual subscriber e-mail settings.

To set subscriber e-mail access options:

1. Start the Web administration console.

2. In the Subscribers section, click Subscriber → E-Mail.

3. Select a subscriber.

Use the Next, Previous, or Find Subscriber icons to locate a subscriber 
profile. The subscriber profile is displayed.

4. Click E-mail.

The subscriber e-mail settings appear.

5. In the e-mail address field, enter the subscriber full e-mail address. For 
example: name@company.com.

Separate up to 5 emals with a space, semi-colon, or comma.

6. Choose a Server type from the drop-down list: POP3 or IMAP.

7. In the Server name field, enter the server IP address or server name.

8. In the User name field, enter the subscriber system ID used to attempt 
authentication with the e-mail server.

9. If appropriate, make sure the Use SSL check box is checked, for SSL 
authentication.

When the SSL check box is checked, the port number 993 appears in 
the field.

10. In the Port field, enter 143 for IMAP; 110 for POP3; or the appropriate 
value for the e-mail server. 

11. If the e-mail system uses authentication, check the Use authentication 
check box, then choose the authentication type from the drop-down list.

12. Click the Save icon.

Repeat this procedure for each existing subscriber. Use the Next, Previous, or 
Find Subscriber icons to display the subscriber profile.

NOTE

For subscriber e-mail integration to work, the subscriber must have 
appropriate access options. Access to e-mail messages from voice mail 
or fax/voice e-mail forwarding or notification.
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Next step…
• Test the e-mail integration.
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SECTION 1 OVERVIEW

Remote maintenance enables administrators to use a remote computer to 
troubleshoot and maintain the voice messaging system. Remote 
maintenance uses the Internet and a network LAN connection or a dial-up 
connection.

Internet and network access requires that the voice messaging system is 
connected to a network that provides Internet access. The network 
administrator must also set up the firewall to enable remote access. To 
access the voice messaging system remotely, the IP address must be 
statically mapped to an outside IP address per IP address or a per TCP 
port.

Dial-up access requires both the voice messaging system and remote 
computer to have modems set up and accessible. Dial-up Networking 
must be configured on the remote computer and the remote computer 
must have an SSH client installed.
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SECTION 2 SETTING UP DIAL-UP MAINTENANCE

The remote computer must have Windows dial-up networking properly configured 
before attempting to connect to the voice messaging system.

To configure dial-up maintenance for the voice messaging system, perform the 
following procedure:

1. From the Main Menu, go to System  →  Configuration  →  Access Number.

2. Specify the internal modem extension (default:  663). 

3. Click the Save button.

2.1 Setting Up the Remote Computer Dial-up Networking

The following procedure is written for a remote computer that is running the 
Windows XP operating system. Use the following procedure to configure the 
dial-up networking.

Refer to the network configuration documentation if a different operating 
system is installed on the remote computer.

1. To set up dial-up networking on a remote computer

2. Click Start  →  My Network Places  →  Properties.

The Network connections properties window appears.

3. Double-click New Connection Wizard.

The New Connection Wizard Welcome page appears.

4. Click Next.

5. Select Connect to the network at my workplace, then click Next.

6. Select Dial-up connection, then click Next.

7. Enter a name for the connection. For example, enter UM8000, then click 
Next.

8. Enter the phone number for the modem at the remote site, then click 
Next.

NOTE

. This is the extension you must dial to establish a remote modem connection with 
the voice messaging system.
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9. Select the My use only connection option, then click Next.

10. Select the Add a shortcut to this connection to my desktop check box, then 
click Finish.

The New Connection Wizard places a shortcut icon on the desktop and 
closes.

SECTION 3 USING A REMOTE COMPUTER

A remote computer that is running a different operating system can be used to access 
the voice messaging system. The TCP/IP settings on the remote computer must be 
set to connect to the default IP address for the voice blade.

3.1 Configuring TCP/IP

This procedure assumes that a network card is installed and correctly 
configured on the remote computer running the Windows XP operating 
system.

3.1.1 Configuring TCP/IP for the Remote Computer

Refer to the system documentation for information about configuring 
the TCP/IP settings for a remote computer that is running a different 
operating system.

1. On the Windows desktop, click Start.

2. Right-click My Network Places, and select Properties.

The Network Connections window appears.

3. Right-click Local Area Connection, then select Properties.

The Local Area Connection Properties window appears.

4. Double-click Internet Protocol (TCP/IP).

5. On the General tab:

a Select Use the following IP address.

b Enter 172.16.1.200 in the IP address field.

c Enter 255.255.255.0 in the Subnet mask field.

d Leave the Default gateway field blank.

e Click OK.

The Internet Protocol properties dialog box closes.

6. Click OK to close the Local Area Connection window.
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3.2 Using Dial-up Connection

The procedures in this section assume that the network administrator has 
helped set up the remote computer for remote dial-up access and that you 
know how to dial-in to the network.

3.2.1 Using WinSCP and Dial-up to Connect Remotely

Use the following procedure to transfer files between the voice 
messaging system and a remote computer.

1. On the Windows Desktop, double-click the Dial-up connection 
icon. 

The Connect page appears. If you are using a network 
connection, go to step 6.

2. In the User name field, enter admin.

3. In the Password field, enter the password: voicemail.

4. Click Dial. 

The modem dials the phone number. If the connection is 
successful, a small icon with two flashing computers appears on 
the Windows taskbar. 

5. On the Windows taskbar, click Start  →  Programs  →  WinSCP3  →  
WinSCP. 

The Login window appears.

6. Enter the Host name or IP address of the voice messaging 
system.  Verify new remote maintenance IP addresses.

If dial-up is being used, enter 10.0.0.1. 

7. Enter the User name, admin.

8. Enter the Password, voicemail.

9. Under Protocol, select SFTP (allow SCP fallback).

10. Click Login.

When the first connection is made, a warning message appears. 
This message does not appear for subsequent connections. Click 
Yes.

After authentication is complete, the WinSCP File Transfer page 
appears.

NOTE
. Consult your network administrator for assistance setting up 

dial-up access to the network.
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3.2.2 Transferring Files to the Remote Computer

This procedure assumes that the Norton Commander interface has 
been selected. The Norton Command interface displays the source 
directory structure in the left pane and the destination directory in the 
right pane. This enables the use of drag and drop to copy files.

1. Select the file or files to copy.

2. Right-click the file name, then select Copy.

Alternatively, if the Norton Commander interface is active, you can 
drag and drop files.

3.2.3 Transferring Files from the Remote Computer

1. Select the file or files to copy.

2. Click Files  →  Copy, then click Copy.

Alternatively, if the Norton Commander interface is active, you can 
drag and drop files.

3.3 Logging On and Logging Off Using PuTTY

Log on and log off after connecting to the UM8000 blade.

3.3.1 Logging On Using PuTTY

1. Click Start > Programs > PuTTY > PuTTY.

The PuTTY configuration dialog box appears.

2. Enter the Host name of the voice messaging server, then click 
OPEN.

The PuTTY client shell appears with a login as prompt.

3. At the login prompt, enter admin <ENTER>.

4. When prompted for the password, enter voicemail <ENTER>.

The Maintenance menu appears when the correct password is 
entered.
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3.3.2 Changing the Admin Password

Changing the admin password secures the computer at the 
operating system level. The system manager should take additional 
steps to secure UM8000 at the voice messaging application level. 
Refer to System Management Help for more information.

This procedure assumes that the mouse is used as an input device.

1. On the Maintenance menu, click 2 Maintenance, then click OK.

The System maintenance menu appears.

2. On the System maintenance menu, click 2 Set admin password, 
then click OK.

The Set admin password window appears.

3. Enter the new password, then click OK.

4. When prompted, enter the new password again, then click OK.

A message appears stating that the password has been changed.

5. Click OK to return to the System maintenance menu.

6. Click 0 Return to previous menu, then click OK to return to the 
Maintenance menu.

7. Click 0 Log out, then click OK to log out and close the PuTTY 
window.

3.3.3 Logging Off

To log off from the operating system, do the following:

3.3.3.1 Logging Off Using PuTTY

1. Return to main Maintenance menu screen.

2. Choose 0 Log Out, then choose OK.

SECTION 4 SINGLE POINT OF ENTRY

When connected to the SV8100 using WebPro or PCPro you can connect directly to 
the UM8000 Web Admin Console (WAC).  The SV8100 knows if the UM8000 is 
installed and running and also knows the IP address assigned to it.  Other than 
normal system programming for the UM8000, no configuration changes are required.

The instructions below show how to connect to the UM8000 from PCPro or WebPro 
after you have connected to the SV8100 system.  The UM8000 must be connected to 
the same LAN as the SV8100 CPU.
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4.1 Using WebPro

1. Log in to the SV8100 with user name tech and password 12345678.

Figure 14-1  WebPro Login
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2. Once logged in, the main screen has a link to the “In-Skin Voice Mail”, if 
the UM8000 is installed and working.

3. WebPro automatically launches your default web browser and connects 
to the UM8000.

4. When prompted, accept the web browser security warning.  

Figure 14-2  WebPro Connection to In-Skin Voice Mail
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Figure 14-3  WebPro Security Certificate Warning
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5.  You are now logged into the WAC.

Figure 14-4  WebPro Web Admin Console
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4.2 PCPro

1. Start PCPro and login with user name tech and password 12345678.   

2. Open the site database.  If the database is not available, connect to the 
SV8100 and download the database before continuing.

3. While connected to the SV8100, chose Links/In Skin Voice Mail 
Server.

4. PCPro  automatically launches the default web browser and connects to 
the UM8000.

Figure 14-5  PCPro Login
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5. When prompted, accept the web browser security warning.    

Figure 14-6  Web Browser Security Certificate Warning
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6.  You are now logged into the WAC.

Figure 14-7  Web Admin Console
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15Backing up and Restoring UM8000

SECTION 1 BACKING UP THE VOICE MESSAGING DATA

The voice messaging database can regularly be backed up using the 
backup and restore utilities. The backup and restore utilities are installed 
on the voice messaging server.

The back up and restore utilities are run from the Web Admin Console 
(WAC). The WAC provides a GUI driven user interface that replaces the 
need to enter Linux commands in a shell.

There are two types of backups:

• Daily – The utility backs up the selected components every morning at 
2:00 a.m.  The database can be saved on the voice mail or on a 
shared Windows network drive.

• Manual – The utility backs up the selected components immediately to 
either the voice mail drive or a shared Windows network drive.

SECTION 2 BACKING UP AND RESTORING UM8000 MAIL DATABASE

Backups can be done manually or daily.  They are saved with the entered 
file name in zip format.  You can choose to save the backup on the voice 
mail hard drive, a USB drive or a Windows shared folder.  

Backups to the hard drive are stored on the voice mail and can be 
downloaded.  Backups to a USB drive are stored on the USB drive.  
Backups to a Windows Shared Folder are not stored on the voice mail.

CAUTION

. If a USB memory stick drive will be used for backup storage, connect it 
before starting the backup.
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2.1 Backing Up the UM8000

2.1.1 Performing a Manual Backup

For a manual backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Backup.

3. Under Manual backup, if the messages should be included in 
the backup check the Include messages in backup box.

4. Choose the drive from the Backup Destination pull down menu:

If backing up to the Hard Drive on the support PC, choose Hard 
Drive.

If backing up to a USB drive, the drive shows up as an option with 
the name of the drive manufacturer.  For example, it might show 
as PNY.

If backing up to a Windows shared drive, choose Windows Shared 
Folder.  If choosing a Windows Shared Folder, you will need to 
know the path to the share (Example: //myComputer/shareName) 
and the log in information (domain, user name, password).

5. Enter the file name to be used for this backup.

6. Enter any comments needed for this backup.

7. Click the backup now icon.

8. The time to backup the database is determined by the size of 
the system and number of messages that must be saved.

2.1.2 Enabling Daily Backup

For a daily backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Backup.

3. If the messages should be included in the backup check the 
box, Include messages in backup.

NOTE

. It is recommended that a USB drive NOT be used for daily backup.
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4. Choose the drive from the Backup Destination pull down menu:

If backing up to the Hard Drive on the support PC choose Hard 
Drive.

If backing up to a USB drive the drive shows up as an option with 
the name of the drive manufacturer.  For example it might show as 
PNY.

If backing up to a Windows shared drive choose Windows Shared 
Folder.  You must also enter the path to the shared folder, the user 
name and password, if needed.  If choosing a Windows Shared 
Folder you need to know the path to the share (Example: //
myComputer/shareName) and the log in information (domain, user 
name, password).

Also, make sure that DNS is defined under Configuration > 
Network in the maintenance menu.

5. If any changes were made, click the save icon.

2.1.3 Downloading a Backup Stored on the Voice Mail Drive

To download a backup stored on the voice mail drive, perform the 
following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu choose Download.

4. If prompted by the Internet browser, choose to allow the 
download.

5. Choose to Save the backup zip file.

6. Browse to the location where the file is to be downloaded on 
the support PC.

7. Click Save.
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2.2 Restoring a Database Back Up to the UM8000

2.2.1 Uploading a Stored Backup to the Voice Mail Drive

To upload a stored backup to the voice mail drive, perform the 
following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. Under Upload an existing backup to the messaging system, 
click on browse.

4. Browse to the location where file is to be stored on the support 
PC.

5. Click Upload File.

2.2.2 Restoring a Previous Backup

To restore a previous backup, perform the following steps:

1. Log in to the Web Admin Console (WAC).

2. Go to Server Control.

3. If started, choose to stop the server.

4. Go to System/Backup and Restore/Restore.

5. In the Action pull down menu, choose Restore this backup.

6. If the backup has messages, confirm you want the messages 
restored with the database.

7. Go to Server Control.

8. Choose to start the server.

2.2.3 Deleting a Stored Database Backup

To delete a stored database backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu, choose Delete.

4. Confirm you want to delete the backup file. 
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2.2.4 Viewing Notes for a Stored Database Backup

To view notes for a stored database backup, perform the following 
steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu, choose View backup note.

4. The note shows as a pop up window.

5. After reading the note, click OK to close the window.
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SECTION 1 MIGRATING FROM OS/2

1.1 About Migration

UM8000 supports migration from previous products. This chapter 
describes the steps required to migrate data from OS/2 and Linux 
based voice messaging systems to the UM8000 Mail.

Migration of most existing data from OS/2 voice messaging system 
to a new UM8000 system is possible. The data includes the system 
configuration settings, subscriber accounts, groups, transaction 
boxes, interview boxes, voice names and greetings, and 
messages. 

On the UM8000 system, verify that the prompt set configuration is 
identical to the prompt set configuration of the OS/2 based voice 
mail system. Otherwise, language settings might not migrate 
properly.

1.2 Backing Up Data Locally

After the backup is complete, compress the files in the proper 
format to migrate to UM8000. This requires transferring a 
compression utility to the OS/2 voice messaging system blade.

1.2.1 Compressing the OS/2 Backup Data

The following procedure uses CoSesssion to compress 
the data, but FTP to transfer the compression utility if the 
OS/2 FTP server is already configured.

NOTE

. Customized prompts cannot be migrated.
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To compress the OS/2 voice messaging system backup data, 
perform the following procedure:

1. Use a CoSession client, connect to the OS/2 voice messaging 
system.

2. Open a command prompt window on the OS/2 system.

3. Change to the E drive. enter E: <ENTER>

4. Enter cd\, then press OK.

5. Enter mkdir archive <ENTER>.

6. Enter move PKOS2250.EXE \archive <ENTER>.

7. Enter cd archive <ENTER>.

8. Enter PKOS2250.EXE <ENTER>.

9. The program extracts the PKZIP.EXE utility to the E:\archive 
directory.

10. Enter cd \backup <ENTER>.

11. To compress the backup file enter:

\archive\pkzip /add /dir=current E:\backup.zip <ENTER>

Where backup.zip is the name of the compress file.

This completes the local backup and compression process.

1.2.2 Transferring Backup Files

After completing a local backup and compressing the backup files, 
transfer the files from the OS/2 voice messaging system to another 
computer for temporary storage.

There are two methods for transferring the files:

• FTP connection
The UM8000 system is set up for networking.

• CoSession
The OS/2 voice messaging system is connected to a remote 
computer using a direct-connect null modem cable.

1.2.3 Using FTP to Transfer Files

An FTP connection requires a network connection to a Windows 
computer. Set up the OS/2 voice messaging  FTP server before 
transferring the files.
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1.2.3.1 Setting Up the OS/2 FTP Server

To set up the OS/2 FTP server:

1. Use CoSession to connect to the OS/2 voice messaging 
system.

2. At the OS/2 command prompt, enter c: <ENTER>.

3. Enter cd \mptn\etc <ENTER>.

4. Open a text editor. Enter e TRUSERS <ENTER>.  

This command creates a new file, TRUSERS and opens the 
text editor.

5. Enter the following lines into the file:

user support voice 

rd e:\

wr e:\ 

6. Save the file and exit the text editor.

7. Start the OS/2 FTP server. Enter c:\tcpip\bin\ftpd 
<ENTER>.

1.2.3.2 Transferring the Backup File Using FTP

To transfer the backup file using the FTP server:

1. At the Windows computer, open a command prompt 
window and enter 

ftp <IP address> <ENTER>

where <IP address> is the IP address of the OS/2 voice 
messaging system.

2. When asked for the user name, enter support <ENTER>.

When asked for the password, enter voice <ENTER>.

3. Enter lcd <directory name> t <ENTER>.

Where <directory name> is the destination directory on the 
Windows computer where the compressed backup file will be 
stored.

4. Enter binary <ENTER>.

This sets the file transfer mode to binary.

NOTE

. The file name must be TRUSERS without a file 
extension.
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The file transfer mode must be set to binary or the migration will 
fail.

5. Enter get <filename> <ENTER>.

Where <filename> is the name of the compressed backup file, 
for example backup.zip. If the file transfer is successful, you 
should see the following message: File send OK. 

6. To exit the FTP client, enter quit <ENTER>.

Next steps…
• Migrate the OS/2 data to the UM8000 

database.  Refer to 1.3 Migrating the Backup 
Data on page 16-4.

1.3 Migrating the Backup Data

After the OS/2 backup data has been transferred to the UM8000 system, start 
the migration. 

To migrate the OS/2 data to the UM8000 database, perform the following 
procedure:

1. Log into the Web Administration Console.

2. Go to System/Backup and Restore/Restore.

3. Use the browse icon to find the database to migrate on the support PC, this 
can include mapped network drives.

4. Choose upload.

After uploading the database, it appears in the local backup list.

5. In the pull down menu for the uploaded database, choose restore.

6. When prompted, confirm to restore this database.

7. When the migration completes, you receive a message.

8. Go to Server Control.

9. Stop the voice messaging system.

10. After the application stops, choose to start the voice messaging system.

NOTE

. File names are case-sensitive when using FTP. If 
you see the Failed to open file error message, 
enter dir <ENTER> to view the correct file name.
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1.4 Setting up OS/2 NetBIOS Backup For Migration

Network protocols must be installed to back up an OS/2 voice messaging 
system using a NetBIOS over TCP/IP. 

A NetBIOS over TCP/IP configuration is required for a an OS/2 voice 
messaging system network backup.  Activation or upgrade codes are not 
required for network backups.

Make sure that the following installation information is available before starting 
the NetBIOS backup for migration: 

1.4.1 Configuring NetBIOS over TCP/IP

Configure TCP/IP and specify a Windows network domain name. If a 
domain does not exist, use the procedure described in Section 1.5 
Setting Up a Remote Windows Computer for a Backup on page 
16-12 in this chapter.

For a network backup using NetBIOS over TCP/IP, set up the system 
to log on to the network.  After installing network protocols, refer to 
Section 1.4.2 Setting Up an OS/2 Voice Messaging System to Log 
On to a Network on page 16-7 in this chapter.

Finally, set up a Windows computer to share a drive with the OS/2 
voice messaging system.  Refer to Section 1.5 Setting Up a Remote 
Windows Computer for a Backup on page 16-12 in this chapter.   

1.4.1.1 Installing Network Protocols for a NetBIOS Backup

1. Log on to the OS/2 voice messaging system.  The 
Banner page appears.

2. Press ESC on the Banner page and follow the system 
prompts.

3. Start an OS/2 command prompt.

Subnet mask

Router

Domain name

Server name

OS/2 voice messaging system
TCP/IP address

NOTE

. Set up the Windows system as a workgroup environment with a 
unique TCP/IP address.
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4. On the OS/2 command prompt, enter f: <ENTER>.

5. Enter cd\ <ENTER>.

6. Enter setup <ENTER>.

7. Enter y to proceed with the voice messaging system set 
up utility.

8. On the Choose Setup Type menu, enter 2 to select 
Configure System, then <ENTER>.

9. Press OK to confirm that the voice messaging system is 
installed on drive E:.

10. Press OK to confirm that the voice messaging system is 
installed in the E:\VMAIL\ directory.

11. The Setup menu displays the features and options 
available on the system. Review the available options, 
then <ENTER>.

12. The Update Configuration menu appears. Click 
Configure Network Protocols (for Network Backup/
Restore) <ENTER>.

Make sure that all other options are cleared, then 
<ENTER>.

13. From the Select Network Protocols to Install/Configure 
menu, enter 2 (TCP/IP) and 3 (NetBIOS over TCP/IP), 
then <ENTER>. 

The TCP/IP Setup menu appears.

14. Enter 1<ENTER>

15. Enter the correct value for the TCP/IP Address field, then 
<ENTER>.

16. Enter 2 <ENTER>.

17. Enter the correct value for the Subnet Mask field, then 
<ENTER>.

18. Enter 3 <ENTER>.

19. Enter the correct value for the Default Router field, then 
<ENTER>.

20. Enter 4 then <ENTER>.
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21. Enter the correct value for the Domain field, then 
<ENTER>

22. Enter 5 then <ENTER>.

23. Enter the correct value for the Name Server field, then 
<ENTER>.

The NetBIOS over TCP/IP Setup menu appears.

24. Enter 1 then <ENTER>.

25. In the Workstation Name field, enter the Windows logon 
name of the voice messaging system, then <ENTER>.

26. Enter 2 then <ENTER>.

27. In the NT Domain Name field, enter the Windows domain 
name of the voice messaging system, then <ENTER>. 

28. Enter 3 then <ENTER>.

29. In the Workstation Description field, enter a description 
for the voice messaging system, then <ENTER>.

30. Review the entries to confirm that they are correct, then 
<ENTER> to continue. 

Setup configures the network protocols according to the 
information provided.

31. When the configuration is complete, the Setup Complete 
menu appears. Press <ENTER> to exit the setup utility.

32. Shut down the OS/2 voice messaging system blade by 
moving the Shutdown Switch to UP.

33. After the system has fully shut down, move the Shutdown 
Switch back to DOWN, then click the Reset button to 
restart the system.

1.4.2 Setting Up an OS/2 Voice Messaging System to Log On to a Network

To enable OS/2 voice messaging system to log on to a Windows 
network with NetBIOS over TCP/IP, perform the following procedure:

NOTE

. If there is no Windows domain, type the Windows 
workgroup name instead.
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1.4.2.1 Logging On to a Windows Network

1. Add a Windows user ID and password with network 
access rights.

2. Specify the IP address of the network Primary Domain 
Controller (PDC).

3. Log on to the Windows domain or workgroup from an 
OS/2 voice messaging system.

4. Map a network drive.

5. Set up OS/2 voice messaging system to automatically 
log on to the Windows network (optional).

1.4.2.2 Adding a User with Network Access Rights

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Log on as an administrator by typing:

logon admin /p:admin <ENTER>

3. Add a user with network access rights by typing:

net user <userid> <password> /add <ENTER>

where <userid> and <password> are a valid user name and 
password on the Windows computer.

The userid and password must match the settings on the 
Windows computer.

4. Enter logoff, then <ENTER>.

1.4.2.3 Specifying the Network Primary Domain Controller IP 
Address

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Enter mpts, then <ENTER>.

The Multi-Protocol Transport Services application starts.

3. In the Multi-Protocol Transport Services dialog box, click 
Configure.

4. In the Configure dialog box, click LAN Adapters and 
Protocols, then click Configure.  The Adapter and 
Protocol Configuration dialog box appears.

5. In Current Configuration click IBM OS/2 NetBIOS over 
TCP/IP, then click Edit.
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6. Click Broadcast list, then click Configure.

7. Make sure the IP address listed in the broadcast list is 
the correct IP address of the Primary Domain Controller 
(PDC) for the Windows domain. 

Consult with your network administrator to determine the 
correct PDC IP address.

8. Click OK to apply the change.

9. Click Close to close the Configure dialog box.

10. Click Exit to close the Multi-Protocol Transport Services 
application.

11. Double-click the Shutdown icon on the desktop to restart 
OS/2.
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1.4.2.4 Logging On to the Windows Domain or Workgroup Using 
NetBIOS

1. On the voice messaging system, go to an OS/2 
command prompt.

2. The command options used depend on if you are logging 
on to a domain or a workgroup:
 

1.4.2.5 Mapping a Windows Network Drive

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Specify a drive name for the NetBIOS share directory by 
entering:

net use x: \\<server>\<share> <ENTER>.

Where <server> is the name of the Windows computer and 
<share> is the name of the shared directory on the Windows 
computer.

Domain

Type:
logon <userid> /p:<password> 

/d:<domain> <ENTER>

Where
user id = Windows user name
password = Windows password
domain = Windows domain name

Workgroup

Type:
logon <userid> /p:<password> <ENTER>

Where
userid = Windows user name
password = Windows password
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1.4.3 Logging On to Windows Automatically

An OS/2 voice messaging system can be configured to automatically 
log on to the Windows network using the following procedure: 

1.4.3.1 Automatically Logging On to Windows Using NetBIOS

1. Make a backup copy of the Startit.cmd file.  Go to the 
OS/2 command prompt and enter:  
e c:\startit.cmd <ENTER>

2. Go to the beginning of the file and insert the following 
command lines. If you are not using a domain, insert 
everything except:  /d:domain.

logon <userid> /p:<password> /d:<domain> <ENTER>

net use h: \\<server>\<share> <ENTER>

Use the correct values in place of <userid> and <password>. 
<Server> is the Windows computer name, and <share> is the 
Windows directory share name.

3. Save the file, then exit the text editor.

4. Shut down the OS/2 voice messaging system blade by 
moving the shutdown switch to SHUTDOWN. After the 
system has fully shut down, move the shutdown switch 
back to RUN, then press the reset button to restart the 
system.

SECTION 2 MIGRATING FROM AD-64 MESSAGING SYSTEMS

2.1 About Migration

The UNIVERGE UM8000 messaging system supports the migration of 
supported products to the current release. This appendix describes the steps 
required to migrate data from NEAXMail® AD-64 to the current version. 

WARNING

. Installations where the AD64 system has names configured First then Last will 
have the first and last names reversed after migration. The migration utility is 
designed for systems where the single AD64 name field is configured Last, 
First. 

WARNING

. When migrating from an AD-64, ensure the system has the required disk space 
to complete the migration process. In most cases, the space needed is double 
the normal backup size.
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The migrated data includes the system configuration settings, subscriber 
accounts, groups, transaction boxes, interview boxes, voice names and 
greetings, and messages.     

When a LAN connection is set up, the backup files can be saved directly to a 
network location. Alternatively, create the backup files on the local hard drive, 
then transfer them to a network location or copy them to removable media. 
Use of pcAnywhere can be used to transfer the files.  

2.1.1 The AvBackup Utility

AvBackup is a utility provided with the NEAXMail® AD-64 system to 
create and restore backups.

AvBackup uses the Windows Backup/Restore utility to back up the 
messaging system data files. AvBackup also backs up and restores 
additional information that the Windows Backup/Restore utility does 
not back up, such as the Windows registry information. For this 
reason AvBackup must be used instead of the Windows Backup/
Restore utility to back up the UNIVERGE UM8000 system.   

Run AvBackup manually, or schedule AvBackup to run automatically 
on a regular basis.

2.1.2 Levels of Backup

AvBackup allows three different backup levels:

• Basic – Includes all system configuration settings, subscriber 
account information, greetings, and voice names.

WARNING

. Customized prompts, MWI configurations, and switch settings cannot be 
migrated.

CAUTION

. Verify that the default language on the UNIVERGE UM8000 messaging system 
is identical to the default language on the NEAXMail® AD-64 system. If the 
default languages are different the language settings might not migrate 
properly.

WARNING

. It is strongly recommended that you store backup files in a location other than 
the local hard drive. If there is a hard drive failure, both the messaging system 
data and the backup data might be lost if these are on the local hard drive.

WARNING

. If AvBackup is not used, parts of the messaging system configuration 
might be lost.
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A basic backup does not include subscriber messages or 
prompts. A basic backup recommended before making any 
substantial changes to mailboxes and transaction boxes.

• Normal – Includes all system configuration settings, subscriber 
account information, greetings, voice names. and all stored 
subscriber messages.

• Complete – Includes all system configuration settings, subscriber 
account information, greetings, voice names, and all system 
prompts.

A complete backup is recommended after customizing prompts 
and to prepare data to be migrated to a newer messaging 
system.

Use the Windows Scheduled Tasks utility to run backups 
automatically on a regular basis. An automatic backup schedule is 
recommended. This ensures that recent backup is available in the 
event of a system failure.

2.1.3 Types of Backups

Run backups in either of two modes:

• Online Mode – In online mode, the messaging system continues to 
run while the backup is in progress.

• Offline Mode – In offline mode, if the messaging system is running, 
it is shut down to perform the backup.

If running a manual backup in offline mode, specify whether or not to 
restart the messaging system when the backup is complete.

If scheduling an automated backup in offline mode, the messaging 
system automatically restarts when the backup is complete. The 
messaging system restarts whether or not it was running before the 
automated backup.

2.1.4 Backup File Names

Backup files are created with a name indicating the type and date of 
the backup, for example Basic Offline Backup January 28 2005.bkf. 
If another backup of the same type is created on the same date, the 
previous file is overwritten.

If another backup of the same type is created on a subsequent date, 
a separate backup file is created.
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2.1.5 Overriding the File Naming Convention

You can override the file naming convention with automatically 
scheduled backups. Add the -o parameter at the end of the backup 
command. This parameter forces all backup files of the same type to 
be replaced by the current backup.

2.2 Backing Up the NEAXMail®  AD-64  Messaging System

Create a manual backup of the NEAXMail®  AD-64 messaging system data to 
be migrated to the UNIVERGE UM8000 messaging system.

To create a manual backup

1. Sign in to the messaging system server using the same rights used to install 
the operating system.
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2. Start the AvBackup utility:

• Double-click the Backup icon on the Windows desktop.

OR

• Click Start > Run.

The Run dialog box appears.

• Type the following in the Open field:

C:\VMail\AvBackup.exe

Alternatively, click Browse to browse and select the AVBackup.exe file.

• Click OK or press ENTER.

The AVBackup window appears.

3. In the Backup Type section select one of the following:

• Online – For an online backup.

• Offline – For an offline backup.

If an offline backup is selected, select the Restart messaging system 
check box to restart the messaging system when the backup is complete. 

4. In the Backup Contents area, select Complete Backup to create a backup 
for the migration.

5. The backup files are placed in the C:\Vm Backup\ folder. Click Browse to 
select a different destination folder.  

6. Click Backup.

7. In the confirmation dialog box click OK to begin the backup process.

The Backup Status dialog box appears, reporting the status of the backup 
process.

8. Click OK on the AVBackup dialog box when backup is complete.

9. Click Close on the AVBackup dialog box to exit the backup utility.  

CAUTION

. If an offline backup is selected when the messaging system is 
running, AvBackup will disconnect any active calls and shut down 
the system before doing the backup.

NOTE

. The file name is automatically generated by the AVBackup utility. For 
example, Complete Offline Backup April 20 2009.bkf.

NOTE

. Optionally copy the backup files from the \Vm Backup\ folder to a 
network location or removable media.



Issue 8.0 UM8000

16 - 16 Database Migration

2.3 Verifying the AD-64 Back Up File Integrity

Under very rare circumstances, the backup procedure can create a corrupt or 
unusable backup. After creating a backup, use the following procedure to 
verify the backup integrity.

This procedure is mandatory when upgrading the operating system from 
Windows 2000 to Windows Server 2003 SP1 or Windows Server 2003 R2 or 
when upgrading to UNIVERGE UM8000.

The upgrade procedure deletes all system data from the hard drive. 
Therefore, it is critical that the backup integrity is verified before upgrading or 
installing a new messaging system.

To verify the backup file integrity

1. Sign in to the messaging system server using the same rights used to install 
the operating system.

2. Open a Windows Explorer window.

3. Navigate to the folder containing the backup file: C:\Vm Backup\.

4. Double-click the backup file.

The Windows Backup utility automatically starts.

5. In the Windows Backup window, click the Restore tab.

6. Click Tools > Create a backup file.

7. In the Backup File Name dialog box, click Browse.

8. In the Select File To Catalog dialog box, navigate to the folder containing 
the backup file, select the backup file, then click Open.

9. In the Backup File Name dialog box, click OK.

• If the backup file is OK, a new media catalog for the backup file appears under 
File in the left pane.

• If the backup is corrupt, an error message appears indicating that the backup 
file is unusable or that there is some other problem with the backup.

Create a new backup file and repeat the backup integrity test. If the 
backup fails the integrity test a second time, contact Technical Support for 
assistance.

10. Close the Windows Backup window.

11. Copy the backup file to an external USB storage device or a network share 
that is accessible by the UNIVERGE UM8000 messaging system.



UM8000 Issue 8.0

Installation Manual 16 - 17

2.4 Migrating the AD-64 Database and Voice Messages

The new version of the messaging system is installed with a default database. 
Use the following procedure to restore an old database and voice messages.

The messaging system restore utility takes the AD-64 backup data file and 
converts it into a format that is recognized by the messaging system database.

Using the Administration Console

To restore the AD-64 backup file to the UM8000 messaging system   

1. Sign in to the messaging system server using the same rights used to install 
the operating system.

2. Sign in to the Administration Console as $nec.

3. On the Linux taskbar, click the Administration Console icon.

4. Sign in to the Administration Console as $nec.

5. Stop the messaging system software:

• Click Server Control.

• Click Stop.

Wait for the messaging system to stop.

6. In the Navigation pane, click System > Backup & Restore > Restore.

7. If the backup file is not listed on the Restore page, click Upload File to 
search for and select the back up file.

8. Select Restore this backup from the Action list to restore the AD-64 
database. Other options include:

• View Backup Note – Select to display the backup note, then click OK to close 
the note.

• Delete – Select to delete the backup file from the hard drive. Click OK to 
confirm the deletion.

• Download – Select to download the backup file. Click Save to select a 
destination and save the back up file.

9. Click OK to confirm you want to restore the file.

The Restoring Backup progress window appears.

10. Click OK once again to restore the messages. This confirmation prompt 
appears only if the backup file includes messages.

NOTE

. Make sure that all users are logged out of the messaging system.
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11. Restart the messaging system software.

• In the Navigation pane click Server Control.

• Click Start on the System Control page.

When the messaging system has restarted, the start icon is greyed out. 
Click View the startup log file to see the start up process.
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17Updating UM8000

SECTION 1 OVERVIEW

Updating the voice messaging system includes installing new languages, 
installing additional ports, applying patches, or installing a new version of 
the software.

All voice mail features are licensed through the CD-CP00-US of the 
SV8100.  A license maybe required to add additional voice messaging 
software language packs or additional voice ports. The license is based on 
the Hardware Key of the CD-CP00-US for the system. Contact your sales 
representative to obtain a new license code.

SECTION 2 CHANGING LICENSING INFORMATION

All licensing is stored on the CCPU.  This allows for failed CD-VM00 to be 
replaced without having to obtain new licenses for the enabled features.  
Licenses are enabled using Web Pro, PC-Pro or phone programming.  
The UM8000 is enabled for the following UM8000 licenses at default:

• 0 Ports Voice Mail

• 5 Seats Unified Messaging

• Three Languages

In addition, the following language prompt sets are loaded at default:

• US English

• French (Canadian)

• Spanish (Latin America)
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SECTION 3 ADDING/REMOVING LANGUAGE PACKS

The following procedures enable you to install new language packs and remove 
existing language packs. 

3.1 Installing New Language Packs

To install the new language packs:

1. Start the Web administration console.  The the Web administration 
console appears.

2. Under System, click Configuration.  The System configuration page 
appears.

3. Click Languages.  The installed language packs appear on the page.

The following table lists the two-letter codes used for the language files and
their associated soft keys.

4. Click Browse.  The Choose file dialog box appears.

5. In the Choose file dialog box, browse to the location where the language 
packs are installed.

6. Choose the language file.

NOTE

. The UM8000 solid state disk only contains prompt sets for three languages. To use 
additional languages, purchase additional licensing.

Code Language

AU Australian English
CT Cantonese
DE German
DK Danish
ED Madrid Spanish
ES Mexican Spanish
FC Canadian French
FR Parisian French
IT Italian
JA Japanese
LA Latin American Spanish
MD Mandarin Chinese
NL Dutch
PI Iberian Portuguese
PT Brazilian Portuguese
UK UK English
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7. Click Open.  The Choose file dialog box closes, the Install Language 
button appears on the Languages page.

8. Click Install Language.  The Updating… button appears. It takes a few 
minutes for the language pack to install.

The following message appears when the language has been installed:
Changes to the voice messaging system have been made. This requires the
voice messaging software to be restarted. Restart the voice mail software
after all system changes have been completed.

9. Click Restart, to restart the voice messaging software.  The Server 
control page appears, both the Start and Stop buttons are greyed out 
while the server shuts down.

10. Reprogram the phone system.

3.2 Removing Language Packs

To remove the language packs:

1. Start the Web administration console.

The the Web administration console appears. 

2. Click Server Control.  The Server control page appears.

3. Click Stop.  The voice messaging software shuts down.

4. Click System Configuration > Languages.  The installed language packs 
appear on the languages page.

5. To remove a language, click the Remove next to the language.

6. Under Quick Links, click Server Control.  The Server control page appears.

7. On the Server Control page, click Start to restart the voice messaging 
system.

SECTION 4 GLOBAL TONE DETECTION

Use the following procedure to run the global tone detection (GTD).  GTD checks the 
phone system or central office tones.

To run Global tone detection:

NOTE

. The voice messaging software must be stopped to remove language 
packs.
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1. Start PuTTY.  The login prompt appears.

2. Log in as admin <ENTER>.

3. Type the password, voicemail <ENTER>.  The Main menu appears.

4. Stop the voice messaging software, click 3 Control, then click OK.  The System 
control menu appears.

5. Click 1 Stop the voice messaging software, then click OK.  The voice messaging 
system stopping appears.

6. Click 1 Configuration, then click OK.  The Configuration menu appears.

7. Click 4-Global tone detection, then click OK.  The Maintenance menu closes and 
a command line interface appears.

8. Select one of the following options. Option 1 is the default.
 

9. Press <ENTER>. The GTD application starts.

1  Detect PBXKSU (switch provided) tones

2  Detect central office (CO) tones. 

3  Exit this application 
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SECTION 5 APPLYING PATCHES, HOT FIXES, OR UPDATES 11.6 AND LATER

For Version 11.6 and later, upgrades to versions other than your current base version 
are not available via Live Update. However, the various compatible Software Updates 
(SUs) for the base version are available. For version 11.6 and later, you do not need 
to install SUs in order. Simply choose the latest SU and apply it to your system. 
Deleting the unused updates is recommended.
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SECTION 6 APPLYING PATCHES, HOT FIXES, OR UPDATES 11.5 SU2 AND 
EARLIER

For versopm 11.5 SU2 and earlier, the upgrade procedure is different. However, 
deleting the upgrade packages that are not needed is still recommended. Upgrading 
to a version higher than your current base version, such as 11.3 to 11.5, will not work 
and deleting any displayed update files is recommended.

Voice messaging system updates might include a full version upgrades or System 
Updates. Depending on the system version, use the Maintenance menu or the WAC 
Live Update page to apply updates to the voice messaging system.

Voice messaging software updates are available from NEC.
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The following two types of updates might be available for your system:

• Version upgrades move your system from one feature version to another. 

• Software Updates (SU) are maintenance packages delivering the latest 
enhancements for your current system. 

SUs are numbered SU1, SU2 and so forth with the SU number matching the 
third digit of the version number. For example 11.5SU1 is same as 11.5.1.

Version upgrades and Software Updates are performed using overlay upgrade scripts 
which refresh the entire operating system and associated applications, in addition to 
upgrading the messaging system. The overlay upgrade scripts upgrade any 
supported version of the system to the latest, as documented below.

Locating the available upgrade scripts:

• For all feature versions: upgrade scripts are available via download.

• For Software Updates: upgrade scripts are available via the Live Update Service 
and download. 

For example: An X.Y customer wanting to get to the latest version of X.Z (X.Z 
SU1) will apply the X.Z(SU1) script available via Live Update Service or manual 
download.

Upgrading your system:

• Backup your messaging system on a network drive using the backup procedure 
earlier in this document.

• Complete the either 11.2.X upgrade steps or the 11.3 and above upgrade steps 
below, depending on your system version.

6.1 Upgrading UM8000 Version 11.2.x

To update voice messaging software version 11.2, use the following 
procedure:
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1. Download the upgrade file.

2. As admin, upload the upgrade file to the /home/admin/ directory via any 
SCP client.

3. From a terminal, sign into the voice mail system as the admin user, 
which will redirect you to the maintenance menu.

4. Navigate to 2 Maintenance and press Enter.

5. Navigate to 2 Command prompt and press Enter.

6. From the command prompt, run cd /home/admin.

7. Run unzip <upgrade filename>.zip to extract the contents of the 
upgrade. 
                 On the actual media, <upgrade filename>.zip looks similar to this: 

                 14861-15738-11.6.0.31-pc.zip

8. Run sudo sh <upgrade filename> (basename of the upgrade zip file) to 
apply the upgrade. 

9. After the upgrade is complete, reboot the system to complete the 
upgrade.

10. Type sudo shutdown -r now to reboot.

11. Update your prompt sets using the Language Disc. The language disc is 
available for download from the support site.
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6.2 Upgrading UM8000 Version 11.3.x or Higher

To update voice messaging software version 11.3 or higher, use the following 
procedure:

1. Download the upgrade file.

1. Use Program 10-55-01 (this may be different for your switch, please see 
your switch documentation for details) to verify the IP address of the slot 
containing the installed voice mail blade.

2. Start an internet browser and enter the IP address followed by /admin in 
the URL window.  For example: 172.16.0.100/admin.

3. Press <ENTER>.

4. Accept the certificate and log into the WAC with the user name $nec. No 
password is required.

5. Once logged in go to System/Live Update.

6. Click on Upload Update.

7. Browse to the location of the update on the support PC.

8. Click on Open. The upgrade file starts uploading automatically. 
Depending on network speed and file size, this could take several 
minutes.

9. To run the update, check the Install button to right of the update file to 
use.

10. Click Apply.

11. Update your prompt sets using the Language Disc. The language disc is 
available for download from the support site.
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6.3 Updating UM8000 Version 11.3.x or Higher Using the Live Update 
Service

To update the current voice messaging software version, use the following 
procedure:

NOTE: The Live Update Service is available in version 11.3 and above. It will 
only apply maintenance packages. To upgrade to a different feature version, 
please see section 5.2 above.

1. Use Program 10-55-01 (this may be different for your switch, please see 
your switch documentation for details) to verify the IP address of the slot 
containing the installed voice mail blade.

2. Start an internet browser and enter the IP address followed by /admin in 
the URL window. For example: 172.16.0.100/admin.

3. Press <ENTER>.

4. Accept the certificate and log into the WAC with the user name $nec. No 
password is required.

5. Once logged in go to System/Live Update.

6. Click on Check for Updates.

7. Check the box under the Install column for the update you would like to 
install.

8. Click on Apply.

9. Update your prompt sets using the Language Disc. The language disc is 
available for download from the support site.



Installation Manual 18 - 1

C
o

n
fig

u
rin

g
 M

o
b

ile
 S

e
rvic

e
s

18Configuring Mobile Services

SECTION 1 DEPLOYMENT AND CONFIGURATION CONSIDERATIONS

How a mobile phone handles voice mail files can vary depending on 
manufacturer and operating system version. If users are having trouble 
downloading and playing voicemail files, consider the following:

iOS based devices using the Safari browser will not recognize the self-
signed security certificate that ships with the messaging system. For these 
devices to operate, you may replace the certificate that ships with the 
messaging system with a certificate from root authority trusted by Safari. If 
that is not practical, you may disable secure browsing completely via 
System > Configuration > General in the Administration Consile. This will 
allow unencrypted access using the http protocol instead of https.

Whether the file will be downloaded or will be streamed to the device will 
depend on the device being used. iOS does not support downloading of 
voicemail files, but will stream them. Android devices may not stream the 
file, but will allow it to be downloaded.

iOS Android

Play audio via 
https

Yes. Message will be 
streamed. End-site 
security certificate 
required.

Yes. End-site security 
certificate required. 
Message will be 
downloaded.

Play audio via http Yes. Message will be 
streamed.

Yes. Message will be 
downloaded.

View faxes via 
https

Yes. Yes.

View faxes via http Yes Yes.



Issue 8.0 UM8000

18 - 2 Configuring Mobile Services


	Read Before Proceeding
	Introduction
	Section 1 About UM8000®
	1.1 Supported Phone Systems
	1.2 Starting the UM8000 for the First Time

	Section 2 About this Guide
	2.1 Documentation Conventions
	2.2 Using the Command Line Interface

	Section 3 Related Documentation
	3.1 Supporting Documents
	3.2 System Management Help

	Section 4 Related Information
	4.1 Client Applications and Protocols
	4.1.1 Locally Installing Online Help Files
	4.1.2 Third-Party Documentation



	WinSCP and PuTTY
	Section 1 Overview
	Section 2 WinSCP
	2.1 Installing WinSCP
	2.2 Using WinSCP
	2.2.1 Running WinSCP
	2.2.2 Using PuTTY from WinSCP


	Section 3 PuTTY
	3.1 Installing PuTTY
	3.2 Configuring PuTTY
	3.3 Using PuTTY


	The Web Administration Console
	Section 1 Overview
	1.1 Supported Internet Browsers
	1.2 Configuring Internet Explorer

	Section 2 Starting the UM8000 for the First Time
	Section 3 Logging On to the Web Administration Console
	3.1 Logging In
	3.2 Logging Off

	Section 4 Web Administration Console Pages
	Section 5 Web Administration Console Icons
	Section 6 Web Administration Console Main Menu

	System Components
	Section 1 Overview
	1.1 System Components
	1.2 NEC-supplied Components
	1.3 User-supplied Components

	Section 2 Site Requirements
	2.1 Site Recommendations
	2.2 Setting Up the System Overview


	Starting and Stopping the Voice Messaging Software and System
	Section 1 Overview
	Section 2 Stopping/Starting Using the Web Administration Console

	Hardware
	Section 1 CD-VM00 Blade (Voice Mail and Server)
	1.1 Description
	1.2 Functions

	Section 2 Installation
	Section 3 Load Push-button Switch
	3.1 To Reset CD-VM00 (APSU) to Default

	Section 4 LED Indications
	Section 5 Connectors
	5.1 RS-232 Interface
	5.2 USB Interface
	5.3 VGA Display Interface
	5.4 10 BASE-T/100 BASE-TX Ethernet Interface


	Setting Up Integration (SV8100/SV9100)
	Section 1 Overview
	Section 2 Setting Up Integration
	Section 3 Configuring Integration
	Section 4 Programming
	4.1 Basic Configuration
	4.2 Class of Service
	4.3 Assign Trunks as Automated Attendant Trunks


	Setting Up Integration (SV8300/SV9300)
	Section 1 Overview
	Section 2 Setting Up Integration
	2.1 Assign Extension Numbers to Voice Messaging Ports
	2.2 Enabling Digital Voice Messaging Support
	2.3 Assign Voice Messaging Ports as Digital Voice Messaging Ports
	2.4 Setting Up the UCD Hunt Group
	2.5 Enabling the Automated Attendant
	2.6 Setting Up Call Forward on Busy or Ring-No-Answer
	2.7 Enabling Busy Greetings
	2.8 Enabling Easy Message Access
	2.9 Disabling Easy Message Access
	2.10 Enabling Automatic Subscriber-to-Subscriber Messaging in Secured Mode
	2.11 Setting Up Message Waiting Indication
	2.12 Setting Up Automatic Number Identification (ANI)
	2.13 Set the IP Address Information for the UM8000
	2.14 Set the UM8000 License that are Loaded in the SV8300

	Section 3 Setting Up Soft Keys
	3.1 Enabling Soft Key Call Screening
	3.2 Enabling the Voice Messaging Ports for Soft Keys

	Section 4 Setting Up Live Record
	4.1 Configuring Live Record on the Phone System
	4.2 Configuring Live Record on a Subscriber’s Extension
	4.3 Configuring Live Record on UM8000

	Section 5 Setting Up Live Monitor
	5.1 Enable Live Monitor on the Phone System
	5.2 Configuring Live Monitor on a Subscriber’s Extension
	5.3 Enabling Live Monitor on UM8000


	Configuring UM8000
	Section 1 Overview
	Section 2 Starting the UM8000 for the First Time
	Section 3 Configuring the Voice Messaging System
	Section 4 Before Shipping the Voice Messaging System
	4.1 Resetting Third-Party Licensing Agreements
	4.2 Defaulting the UM8000 Database

	Section 5 Setting Up the UM8000 Software
	5.1 Configuring Network Setup
	5.2 Specifying the Network Setup
	5.3 Setting Up UM8000 Date and Time
	5.4 Changing Administrator Password and Creating a New User
	5.4.1 Changing the Password
	5.4.2 Creating a New User



	Configuring Presence
	Section 1 Overview
	Section 2 NEC UC Desktop Suite
	Section 3 Internal UM8000 Presence
	Section 4 Configuring Presence

	Setting Up Visual Messaging Integration
	Section 1 Visual Messaging Overview
	1.1 Setup Steps

	Section 2 Visual Messaging Hardware and Software Requirements
	Section 3 Connecting the Voice Messaging Computer to a LAN
	Section 4 Specifying Station Numbers for ViewCall Plus

	Setting Up Visual Messaging Workstations
	Section 1 Visual Messaging Workstation Overview
	1.1 Workstation Requirements
	1.2 Set up Steps

	Section 2 Setting up the TCP/IP Network Protocol
	Section 3 Setting up TCP/IP for Windows 7 and 8.1
	Section 4 Testing the TCP/IP Setup
	Section 5 Using Visual Messaging Applications with WANs and the Internet

	E-mail Integration
	Section 1 Overview
	Section 2 Protocols
	2.1 E-mail Protocols
	2.2 Subscriber E-mail Authentication Protocols

	Section 3 E-mail Integration Set Up
	Section 4 Configuring the E-mail Servers
	4.1 Setting the E-mail Server Configuration
	4.2 Converting Existing Domino E-mail Files for Users
	4.2.1 Converting Existing E-mail Files


	Section 5 Configuring the Voice Messaging System
	5.1 Configuring the Voice Messaging System for E-mail Forwarding Integration
	5.2 Configuring the Voice Messaging System for Text-to-Speech Integration
	5.3 Configuring the E-mail Notification Template

	Section 6 Setting Up Subscriber Mailboxes
	6.1 Setting Up the Default Subscriber Template
	6.2 Setting Subscriber E-mail Options


	Remote Maintenance
	Section 1 Overview
	Section 2 Setting Up Dial-up Maintenance
	2.1 Setting Up the Remote Computer Dial-up Networking

	Section 3 Using a Remote Computer
	3.1 Configuring TCP/IP
	3.1.1 Configuring TCP/IP for the Remote Computer

	3.2 Using Dial-up Connection
	3.2.1 Using WinSCP and Dial-up to Connect Remotely
	3.2.2 Transferring Files to the Remote Computer
	3.2.3 Transferring Files from the Remote Computer

	3.3 Logging On and Logging Off Using PuTTY
	3.3.1 Logging On Using PuTTY
	3.3.2 Changing the Admin Password
	3.3.3 Logging Off
	3.3.3.1 Logging Off Using PuTTY



	Section 4 Single Point of Entry
	4.1 Using WebPro
	4.2 PCPro


	Backing up and Restoring UM8000
	Section 1 Backing Up the Voice Messaging Data
	Section 2 Backing Up and Restoring UM8000 Mail Database
	2.1 Backing Up the UM8000
	2.1.1 Performing a Manual Backup
	2.1.2 Enabling Daily Backup
	2.1.3 Downloading a Backup Stored on the Voice Mail Drive

	2.2 Restoring a Database Back Up to the UM8000
	2.2.1 Uploading a Stored Backup to the Voice Mail Drive
	2.2.2 Restoring a Previous Backup
	2.2.3 Deleting a Stored Database Backup
	2.2.4 Viewing Notes for a Stored Database Backup



	Database Migration
	Section 1 Migrating from OS/2
	1.1 About Migration
	1.2 Backing Up Data Locally
	1.2.1 Compressing the OS/2 Backup Data
	1.2.2 Transferring Backup Files
	1.2.3 Using FTP to Transfer Files
	1.2.3.1 Setting Up the OS/2 FTP Server
	1.2.3.2 Transferring the Backup File Using FTP


	1.3 Migrating the Backup Data
	1.4 Setting up OS/2 NetBIOS Backup For Migration
	1.4.1 Configuring NetBIOS over TCP/IP
	1.4.1.1 Installing Network Protocols for a NetBIOS Backup

	1.4.2 Setting Up an OS/2 Voice Messaging System to Log On to a Network
	1.4.2.1 Logging On to a Windows Network
	1.4.2.2 Adding a User with Network Access Rights
	1.4.2.3 Specifying the Network Primary Domain Controller IP Address
	1.4.2.4 Logging On to the Windows Domain or Workgroup Using NetBIOS
	1.4.2.5 Mapping a Windows Network Drive

	1.4.3 Logging On to Windows Automatically
	1.4.3.1 Automatically Logging On to Windows Using NetBIOS



	Section 2 Migrating from AD-64 Messaging Systems
	2.1 About Migration
	2.1.1 The AvBackup Utility
	2.1.2 Levels of Backup
	2.1.3 Types of Backups
	2.1.4 Backup File Names
	2.1.5 Overriding the File Naming Convention

	2.2 Backing Up the NEAXMail® AD-64 Messaging System
	2.3 Verifying the AD-64 Back Up File Integrity
	2.4 Migrating the AD-64 Database and Voice Messages


	Updating UM8000
	Section 1 Overview
	Section 2 Changing Licensing Information
	Section 3 Adding/Removing Language Packs
	3.1 Installing New Language Packs
	3.2 Removing Language Packs

	Section 4 Global Tone Detection
	Section 5 Applying Patches, Hot Fixes, or Updates 11.6 and Later
	Section 6 Applying Patches, Hot Fixes, or Updates 11.5 SU2 and Earlier
	6.1 Upgrading UM8000 Version 11.2.x
	6.2 Upgrading UM8000 Version 11.3.x or Higher
	6.3 Updating UM8000 Version 11.3.x or Higher Using the Live Update Service


	Configuring Mobile Services
	Section 1 Deployment and Configuration Considerations


